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Disclaimer 

The information in this document is subject to change without notice and does not repre-
sent a commitment on the part of Native Instruments GmbH. The software described by 
this document is subject to a License Agreement and may not be copied to other media. 
No part of this publication may be copied, reproduced or otherwise transmitted or record-
ed, for any purpose, without prior written permission by Native Instruments GmbH, herein-
after referred to as Native Instruments. All product and company names are TM or ® trade-
marks of their respective owners. 

Document authored by: Nicolas Sidi 
Product Version: 1.2.5 

Special thanks to the Beta Test Team, who were invaluable not just in tracking down bugs, 
but in making this a better product. 
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Welcome to the Controller Editor! 

1 Welcome to the Controller Editor! 
Welcome to the Controller Editor! This powerful tool turns your Native Instruments hard-
ware controller device into a versatile and efficient MIDI remote control for your studio 
and/or live setup. 
With the Controller Editor, you can precisely define which MIDI message has to be sent 
upon any action you do on your NI Controller. This way, you can put all you music setup 
right at your fingertips and remote control every MIDI-capable software or hardware from 
your NI Controller. After having prepared your MIDI assignments with the Controller Editor, 
you can focus on what it's all about: making music! 
Yours sincerely, 
The team at Native Instruments 

About This Manual 

This manual is divided into three parts: 
• First, we will introduce you to the Controller Editor: after a short description of the 

installation procedure (chapter 12. Installation), we will start with a brief tutorial 
(chapter ' 3 Quick Start). 

• The second part illustrates the software's user interface, the Controller Editor's map-
ping scheme and the various ways to interact with the software (chapter ' 4, Basic 
Concepts); it also shows you how to use your particular NI Controller (chapter ' 5, Us-
ing your MASCHINE Controller, chapter 6. Using your KORE Controller, chapter 
t 7, Using your TRAKTOR KONTROL X1, chapter ' 8, Using your RIG KONTROL 3, 
and chapter 19, Using your AUDIO KONTROL 1). This will familiarize you with Con-
troller Editor's workflow. 

• The third part is a detailed reference, describing the software interface and its opera-
tion. Read chapter ' 10. Reference for information on every knob, button or field 
present on the Controller Editor's interface. 

M This manual generally refers to all Native Instruments hardware controller devices simply 
as "NI Controller." If any information applies to a specific device only, e.g. the MA-
SCHINE Controller, this will be mentioned explicitly. 
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Installation 

2 Installation 

2.1 MASCHINE Owners: Installing from the MASCHINE Installation DVD 
The Controller Editor is included in the MASCHINE software package and should have 
been installed during the MASCHINE installation process. Thus, normally it does not need 
any specific installation. If for any reason the Controller Editor is not installed on your 
computer, please insert the MASCHINE DVD into your optical drive and launch the instal-
lation process (for a detailed description of the MASCHINE installation process, please re-
fer to the MASCHINE Reference Manual / Getting Started). During this process, when you 
get to the step asking you to choose which piece of software you wish to install, check only 
the Controller Editor checkbox, and click on the "Next" button. You can leave all other op-
tions (installation directory, etc.) to their default value or choose different settings accord-
ing to your needs. 

2.2 KORE Owners: Installing from the KORE 2.1 Update Installer 
The Controller Editor is included in the KORE 2 software package starting from version 
2.1. If you purchased KORE 2 after this date, the Controller Editor should have been in-
stalled during the KORE 2 installation process. Thus, it does not need any specific instal-
lation. If for any reason the Controller Editor is not installed on your computer, please in-
sert the KORE 2 DVD into your optical drive and launch the installation process again (for 
a detailed description of the KORE 2 installation process, please refer to the KORE 2 Op-
eration Manual / Setup Guide). During this process, when you get to the step asking you to 
choose which piece of software you wish to install, check only the Controller Editor check-
box, and click on the "Next" button. You can leave all other options (installation directory, 
etc.) to their default value or choose different settings according to your needs. 
If you purchased KORE 2 prior to this date, launch the NI Service Center and download 
and install the last KORE 2 update—it will include the Controller Editor. During the instal-
lation process, follow the instructions on the screen. By default, the Controller Editor will 
be installed in the directory "Programs/Native Instruments/Controller Editor" (on Windows 
systems) or "Applications/Native Instruments/Controller Editor" (on Mac OS® X systems). 
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Installation 
GUITAR RIG Owners: Installing from the GUITAR RIG 4 Installation DVD 

2.3 GUITAR RIG Owners: Installing from the GUITAR RIG 4 Installation 
DVD 

The Controller Editor is included in the GUITAR RIG 4 software package and should have 
been installed during the GUITAR RIG 4 installation process. Thus, normally it does not 
need any specific installation. If for any reason the Controller Editor is not installed on 
your computer, please insert the GUITAR RIG 4 DVD into your optical drive and launch the 
installation process (for a detailed description of the GUITAR RIG 4 installation process, 
please refer to the GUITAR RIG 4 Application Reference / Getting Started). During this 
process, when you get to the step asking you to choose which piece of software you wish to 
install, check only the Controller Editor checkbox, and click on the "Next" button. You can 
leave all other options (installation directory, etc.) to their default value or choose different 
settings according to your needs. 

2.4 TRAKTOR KONTROL X1 Owners 
The Controller Editor is included in the TRAKTOR KONTROL X1 software package and 
should have been installed during the TRAKTOR KONTROL X1 installation process. Thus, 
normally it does not need any specific installation. 
If for any reason the Controller Editor is not installed on your computer, please insert the 
TRAKTOR KONTROL X1 DVD into your optical drive and launch the installation process 
(for a detailed description of the TRAKTOR KONTROL X1 installation process, please refer 
to the TRAKTOR KONTROL X1 manual / Getting Started). 

2.5 AUDIO KONTROL 1 Owners 
The Controller Editor is included in the AUDIO KONTROL 1 software package starting 
from version April 2010. If you purchased the AUDIO KONTROL 1 after this date, the 
Controller Editor should have been installed during the AUDIO KONTROL 1 installation 
process. Thus, it does not need any specific installation. If for any reason the Controller 
Editor is not installed on your computer, please insert the AUDIO KONTROL 1 DVD into 
your optical drive and launch the installation process again (for a detailed description of 
the AUDIO KONTROL 1 installation process, please refer to the AUDIO KONTROL 1 Man-
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Installation 
Downloading the Controller Editor from the Native Instruments Website 

ual/Setup Guide). During this process, when you get to the step asking you to choose 
which piece of software you wish to install, check only the Controller Editor checkbox, and 
click on the "Next" button. You can leave all other options (installation directory, etc.) to 
their default value or choose different settings according to your needs. 
If you purchased AUDIO KONTROL 1 prior to this date, launch the NI Service Center and 
download and install the last AUDIO KONTROL 1 update—it will include the Controller 
Editor. During the installation process, follow the instructions on the screen. By default, 
the Controller Editor will be installed in the directory "Programs/Native Instruments/Con-
troller Editor" (on Windows systems) or "Applications/Native Instruments/Controller Edi-
tor" (on Mac OS® X systems). 

2.6 Downloading the Controller Editor from the Native Instruments 
Website 

You can also download the Controller Editor installer directly from the Native Instruments 
website. To do this, open your favorite internet browser and go to the following URL: 
http://www.native-instruments.com/updates 
Follow the instructions on the website, download the file "Hardware Controller Support 
Setup.exe" (Windows) or "Hardware Controller Support Installer" (Mac OS® X) and save it 
on your hard disk. 
This downloaded file contains the full installation package, including the background serv-
ice needed to establish the connection between your NI Controller and your computer, and 
the Controller Editor software described in this manual. 
Once you have downloaded and saved the file, navigate to the directory where you saved 
the file and double-click it. This launches the installer. The installation process is straight-
forward: follow the instructions on the screen (you can leave the few options at their de-
fault values), and you're done. 
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Quick Start 

3 Quick Start 
This chapter provides a hands-on introduction to the Controller Editor. In chapter ' 10. 
Reference you will find all details about every element of the software. 
The use of the Controller Editor is straightforward. Most actions can be done either from 
your NI Controller or via the Controller Editor interface, and this in various ways—you can 
choose the one that best fits your needs. In the sections below, we will quickly mention 
different ways-of-doing for each step—but you will find all possible actions described later 
in this manual. 

3.1 Preparations 
At this point, we assume that: 
• Your computer is up and running. 
• You have already installed the Controller Editor along with all its background compo-

nents (see chapter ' 2, Installation for more info on this). 
• Your NI Controller is physically connected to your computer. 

3.2 Connecting your NI Controller to the Controller Editor Software 
First of all, except for the RIG KONTROL 3, it is not necessary to start the Controller Edi-
tor software in order to use your NI Controller as a MIDI remote control! Pressing Shift + 
Control on the MASCHINE Controller, Fl then Control on the KORE 2 Controller or Shift + 
Hotcue on the TRAKTOR KONTROL X1 switches your NI Controller to MIDI Mode even 
without the Controller Editor software running. For the AUDIO KONTROL 1, it is even sim-
pler: it is always in MIDI Mode. 
In order to modify the assignments of your NI Controller as a MIDI remote control, on the 
other hand, you need to connect it to the Controller Editor software first. 
Launch the Controller Editor: 
• On Windows XP, select Start > All Programs > Native Instruments > Controller Editor 

> Controller Editor. 
• On Mac OS® X, open the Finder and double-click Applications > Native Instruments 

> Controller Editor. 
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Quick Start 
Connecting your NI Controller to the Controller Editor Software 

This will automatically switch any connected Controller to the MIDI Mode. You can check 
this by looking at the Connect button in the Application Control Bar, in the top part of the 
Controller Editor window: 

Fig. 3.1. The Connect button. 

If the Connect button is lit, your Controller is in MIDI Mode (and thus is connected to the 
Controller Editor). 
If, for any reason, this is not the case (for example, if you have started the MASCHINE, 
KORE, GUITAR RIG or TRAKTOR software after the Controller Editor), use either way to 
establish the connection manually: 
• On your MASCHINE Controller, press the buttons SHIFT + CONTROL (MIDI) to acti-

vate the MIDI Mode: 

• On your KORE 2 Controller, press the buttons Fl then Control to activate the MIDI 
Mode: 

• On your KORE 1 Controller, press the buttons View then Control to activate the MIDI 
Mode. 
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Quick Start 
Connecting your NI Controller to the Controller Editor Software 

• On your TRAKTOR KONTROL Xl, press the buttons SHIFT + HOTCUE (MIDI) to acti-
vate the MIDI Mode: 

• In the Controller Editor, click the Connect button to (re)connect your NI Controller to 
the Controller Editor. 

M RIG KONTROL 3: There is no way for switching to MIDI Mode from your RIG KONTROL 3. 
To do this, please use the Connect button in the Controller Editor. 

M AUDIO KONTROL 1: The MIDI Mode is the only available mode, and thus it is always ac-
tive. Hence, there is no need for any kind of switching. 

Now, your Controller acts as a MIDI remote control and you can use the Controller Editor 
to create and edit MIDI assignments. 

M If the Connect button is grayed out and inactive, check the connection between your NI 
Controller and your computer. 

Re-connecting the MASCHINE Controller to the MASCHINE Software 

If you want the MASCHINE Controller to control the MASCHINE software again, you need 
to re-connect it. To establish a connection between the MASCHINE Controller and the MA-
SCHINE software again, use either one of the following methods: 
• On your MASCHINE Controller, press the buttons Shift + Control (MIDI) to switch it to 

MASCHINE Mode: 

• Click the Connect button in the MASCHINE software's Header to switch the MA-
SCHINE Controller to MASCHINE Mode: 
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Quick Start 
Connecting your NI Controller to the Controller Editor Software 

More information on switching the MASCHINE Controller's modes is available in the MA-
SCHINE manual and in section ' 9 2 2. Connect Button in this manual. 

Re-connecting the KORE Controller to the KORE 2 Software 
If you want the KORE Controller to control the KORE 2 software again, you need to re-con-
nect it. To establish a connection between the KORE Controller and the KORE 2 software 
again, use either one of the following methods: 
• On your KORE Controller, press the button Fl, then Control (or View, then Control on 

the KORE 1 Controller): 

• Click the Connect button in the KORE 2 software's Header to switch the KORE Con-
troller to KORE Mode: 

More information on switching the KORE Controller's modes is in section ' 9.2.2. Connect 
Button in this manual. 

Re-connecting the RIG KONTROL 3 to the GUITAR RIG 4 Software 
If you want the RIG KONTROL 3 to control the GUITAR RIG 4 software again (or one of its 
instances), you need to re-connect it. To do this: 
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Quick Start 
Connecting your NI Controller to the Controller Editor Software 

1. Show the Virtual Rig Kontrol in GUITAR RIG 4's interface by activating its button in 
the Toolbar, at the top of the Rack: 

2. In the Virtual Rig Kontrol that appears at the Rack's bottom, click on the Active LED 
in the top left corner: 

More information on switching the RIG KONTROL's modes is in section 9.2.2, Connect 
Button in this manual. 

Re-connecting the TRAKTOR KONTROL X1 to the TRAKTOR Software 

If you want the TRAKTOR KONTROL X1 to control the TRAKTOR software again, you need 
to re-connect it. To establish a connection between the TRAKTOR KONTROL X1 and the 
TRAKTOR software again, do the following: 
• On your TRAKTOR KONTROL Xl, press the buttons Shift + Hotcue (MIDI): 

O When TRAKTOR is running, the MIDI functionality of your TRAKTOR KONTROL X1 can 
be disabled with a Preferences option on the KX1 preferences page called Switch to MIDI 
via Shift+Hoteue (enabled by default). The purpose of this option is to avoid erroneous 
switching into MIDI mode during heavy usage of Shift and Hotcue Buttons. 
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Quick Start 
Loading assignments 

3.3 Loading assignments 

3.3.1 Selecting a Template 

You first have to select a Template—a full set of assignments for all assignable control ele-
ments on your NI Controller. You can do this either from your NI Controller or from the 
Controller Editor software. 

O A Template is a whole set of MIDI assignments for your NI Controller. More info on this in 
section ' 4.3. The Mapping System! 

Hardware 

• On your MASCHINE Controller, while holding the Shift button depressed, use the 
Page Buttons (the two arrow buttons in the top left part) to scroll through all available 
Templates. 

• On your KORE 2 Controller, press the Fl button and use the Up/Down Arrow Buttons 
to scroll through all available Templates. 

M If you have the KORE 1 Controller, use the View button instead of the Fl button. 
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Quick Start 
Loading assignments 

a On the RIG KONTROL 3, TRAKTOR KONTROL X1 and AUDIO KONTROL 1, there is no 
possibility to select the Templates. To do this, you have to use the Controller Editor inter-
face (see below). 

Software 
• In the Controller Editor, select a Template from the Template Select menu in the Ap-

plication Control Bar, in the top part of the Controller Editor window (after having 
checked that the Device menu on the far left displays the Controller that you are cur-
rently using): 

Fig. 3.2. The Template Select menu also allows you to load the desired Template. 

Either way, the Template will automatically be loaded upon selection and its assignments 
will be displayed. You can now control the software from your NI Controller. 
Each assignment is recalled at the last state of use: the software remembers the last value 
for each of the control elements assigned in this Template. If it's the first time that you 
load a Template, all assignments are at their default value. 

3.3.2 Selecting Knob Pages and Pad Pages on the MASCHINE Controller 

Some of the control elements of your MASCHINE Controller can have multiple assign-
ments which are organized in pages: 
• The eight buttons and eight knobs sitting around the two Displays. The so-called 

"Knob Pages" are subgroups of assignments for these control elements. 
• The sixteen Pads. The so-called "Pad Pages" are subgroups of assignments for these 

control elements. The Pad Page feature may be activated or not in the selected Tem-
plate. 
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Quick Start 
Loading assignments 

O More info on Knob Pages and Pad Pages in section t4.3, The Mapping System! 

Thus, you may need to select a particular Knob Page and/or Pad Page of assignments for 
loading. To do this, follow these steps: 
1. Select the Knob Page that you want to use. Again, you can do this from your MA-

SCHINE Controller, for example by using the Page Buttons (the same two arrow but-
tons as above, but without holding Shift depressed—see picture below), or in the 
Controller Editor, for example by using the Knob Page menu (the orange menu above 
the orange frame). 

2. Provided that the Pad Pages are activated in the current Template (see section '4.3. 
The Mapping System), select the Pad Page that you want to use. This can be done 
both from your MASCHINE Controller by pressing one of the Group Buttons labeled A 
to H in the Groups area (see picture below), and in the Controller Editor, for example 
by using the Pad Page menu (the blue menu above the blue frame around the Pads). 

Fig. 3.4. The MASCHINE Controller Group Buttons. 

The Group Buttons on your MASCHINE Controller allow you to select the desired Pad Page 
(a set of assignments for the Pads). 
Section 1 5.4, The Displays will show you another way to select and load Templates and 
Knob Pages from your MASCHINE Controller, via its two Displays. 
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Loading assignments 

3.3.3 Selecting Knob Pages on the KORE Controller 
Some of the control elements of your KORE Controller can have multiple assignments 
which are organized in pages: 
• The eight Controller Knobs and eight Controller Buttons. The so-called "Knob Pages" 

are subgroups of assignments for these control elements. 
Thus, you may need to select a particular Knob Page of assignments for loading. To do 
this, use one of the following methods: 
• From your KORE Controller, use the Up and Down Arrow Buttons to switch to the pre-

vious or next Knob Page (provided that you are not in the Settings nor Options Display 
Mode—see section P 6.4, The Display): 

You can select the previous/next Knob Page via the Up/Down Arrows Buttons on your 
KORE Controller. 
• In the Controller Editor, use the Knob Page menu (the orange menu above the orange 

frame) to select the desired Knob Page. 
Section ' 6 4 The Display will show you another way to select and load Templates and 
Knob Pages from your KORE Controller, via its Main Display. 

3.3.4 Selecting Knob Pages on the TRAKTOR KONTROL X1 
Within each Template, all control elements on your TRAKTOR KONTROL X1 (with the ex-
ception of the Shift and Hotcue Buttons) can have two assignments organized in two so-
called "Knob Pages": the Basic page (default name) holds one set of assignments for the 
whole controller, and the Shift page (default name) holds another set of assignments. 
Thus, you need to select a particular Knob Page of assignments for loading. To do this, 
use one of the following methods: 
• From your TRAKTOR KONTROL Xl, use the SHIFT Button to switch between the two 

available Knob Pages: 
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Fig. 3.5. The SHIFT Button on the TRAKTOR KONTROL X 1. 

M This Shift Button can have two operating modes: it activates the new page whether for the 
time it is hold depressed (Gate mode), or until the next time you press it again (Toggle 
mode). Please refer to section t 7.2.1, Switching Between Knob Pages for more info on 
this. 

• In the Controller Editor, use the Knob Page menu (the orange menu above the orange 
frame) to select the desired Knob Page. 

3.3.5 Selecting Knob Pages on the AUDIO KONTROL 1 
Within each Template, all control elements on your AUDIO KONTROL 1 (with the excep-
tion of the Left Button) can have two assignments organized in two so-called "Knob Pa-
ges": the Basic page (default name) holds one set of assignments, and the Shift page (de-
fault name) holds another set of assignments. 
Thus, you need to select a particular Knob Page of assignments for loading. To do this, 
use one of the following methods: 
• From your AUDIO KONTROL 1, use the Left Button to switch between the two availa-

ble Knob Pages: 

Fig. 3.6. The Left Button on the AUDIO KONTROL 1 

M This Left Button can have two operating modes: it activates the new page whether for the 
time it is hold depressed (Gate mode), or until the next time you press it again (Toggle 
mode). Please refer to section 19.2 Special Control Elements for more info on this. 
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• In the Controller Editor, use the Knob Page menu (the orange menu above the orange 
frame) to select the desired Knob Page. 

3.3.6 Ready to go? 

If you only plan to use this Template (and Knob Page/Pad Page) as it is, i.e. without modi-
fying any of its MIDI assignments, you're done! As you may have noticed, you can do all 
this from within your MASCHINE Controller, KORE Controller or TRAKTOR KONTROL X1 
—this being of course the preferred way for any live situation. If you used the Controller 
Editor, you can close the application now—the corresponding NI background service will 
take care of everything—and you can start using your NI Controller as a MIDI remote con-
trol right away! 

3.4 Modifying an Assignment 
Now, if you want to modify some of the assignments stored in the selected Template (and 
possibly one of its Knob Pages and/or Pad Pages), continue with these few more steps: 
1. Select the control element for which you want to edit the assignment. You can do this 

either in the Controller Editor by clicking on the control element within the hardware 
representation (see picture below), or from your NI Controller by touching the control 
element (for this, the Touch Select option needs to be activated in the General tab of 
the Preferences window—this is the default setting). A double-click on the control el-
ement—instead of a single click—at this point brings the Inspector's Assign tab auto-
matically to the front, for faster editing! The control element selected for editing is 
then surrounded by the red Selection Frame in the Controller Editor: 

2. Go to the Inspector (the right part of the Controller Editor's interface) and click on the 
Assign tab: 

Controller Editor - Operation Manual - 23 

EFTA_R1_00171043 

EFTA01810145



Quick Start 
Organizing Your Assignments 

3. In this tab, all assignment's properties for that control element are displayed. Modify 
them according to your needs: at the top, you can edit the name of the assignment, 
and below, all MIDI properties like the type of MIDI message to be sent, the MIDI 
channel to use, and so on. The assignment's details differ depending on the type of 
MIDI message you choose. 

Fig. 3.7. You will find a detailed explanation of all possible tweaks on the MIDI assignment in chapter 10. 

That's it! Now, the corresponding control element on your NI Controller triggers the MIDI 
message that you just defined. 

3.5 Organizing Your Assignments 
Thanks to its powerful mapping system, the Controller Editor lets you organize your assign-
ments as you like. You can define various Knob Pages, Pad Pages and Templates to ad-
dress various situations: For example, you could define different Knob Pages to control dif-
ferent instruments in your setup. Furthermore, you could prepare different Templates for 
different songs of your live performance, with all necessary Pad Pages and Knob Pages in-
side. 
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To manage (create, delete, duplicate, etc.) your Templates, Knob Pages or Pad Pages, use 
the two other tabs of the Inspector, namely Templates and Pages. 

The Templates tab and Pages tab allow you to organize your assignments. 
On the Templates tab, you find a list of all available Templates (both factory and user-de-
fined), along with an Edit menu holding all managing commands (e.g. New, Duplicate, De-
lete, etc.). Below, one or two additional menus allow you to choose a Pad sensitivity (MA-
SCHINE Controller only) and the MIDI port to use (either internal or external) with the se-
lected Template. 
On the Pages tab, an equivalent list is available for the Knob Pages (at the top) and, only 
for the MASCHINE Controller, for the Pad Pages (at the bottom), along with their corre-
sponding Edit menus. 

The pages functionality is not available on the RIG KONTROL 3. 

Let's say you have just defined a Knob Page that controls one of your software synthesiz-
ers. You might want to rename it so that you easily remember its purpose: 
1. In the Knob Page List, double-click on the Knob Page that you just defined (let's say 

"Knob Page 3"). Its name gets highlighted. 
2. Type a new name for this Knob Page (for example, "Absynth Lead") and press [Enter) 

on your computer keyboard to confirm the change (You may want to put this Knob 
Page at the top of the list, e.g. if you plan to use this synthesizer at first in your song 
and want to have direct access to its parameters from your Controller): 

3. Click on the Knob Page Absynth Lead in the list, hold the mouse button depressed 
and drag your mouse toward the top of the list. An insertion line appears to show you 
the place where the Knob Page is going to be moved to. 
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4. When the insertion line reaches the top of the list (or the desired insertion place, 
wherever it is), release the mouse button. The Knob Page "Absynth Lead" takes its 
new place in the list. 

M The two available Knob Pages on the TRAKTOR KONTROL X1 and on the AUDIO KON-
TROL 1 cannot be reordered. 

This way-of-doing can also be applied to the Pad Pages (at the bottom of this pages tab, 
only for the MASCHINE Controller) as well as to the Templates (on the Templates tab). 
The Edit menus offer more managing features—you will find all necessary info in the next 
chapters (mainly sections 14.2.4, Inspector and 10.4.3, The Assign Tab). For a detailed 
description of the mapping system, please refer to section t4.3, The Mapping System. 

3.6 Saving and Loading Templates 
Once you have defined a set of assignments that fits your needs, you have the possibility 
to save it. 
Actually, you don't necessarily need to save it, since the Controller Editor automatically 
saves any changes made to the Template on which you are working (and its included Knob 
Pages, Pad Pages and single assignments). So if you only plan to use this Template later 
on the same computer, you can quit the Controller Editor, the Template will be recalled 
with all modifications next time you switch your NI Controller to MIDI Mode and select this 
Template again (if you switched to another Template in the meanwhile). 
But you may want to use a modified or a newly created Template on another computer or 
you may want to share your Template with other users. For that, the Controller Editor al-
lows you to export a Template as a Template file (extension ".ncm", ".nck", ".ncg", 
".nckx1" or ".nckl"): 
1. Go to the Templates tab of the Inspector and select the desired Template by clicking 

its entry in the Template List. The selected Template is highlighted: 
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2. Below the list, click on the Edit menu and select Save As: 

3. A Save template dialog opens and lets you choose the destination and the name of 
the Template file to be exported. Please note that the file name that you choose can 
be different from the Template's name inside the Controller Editor. Once this is done, 
click on "Save" to export the file and you're done. 

You can now transfer this Template file to another computer, share it with a friend, etc. 
On the other side, as you would expect, the Controller Editor also allows you to load a 
Template file. To do this: 
1. In the Templates tab of the Inspector, click on the Edit menu, select Append and 

choose Open. An "Open template" dialog appears that lets you navigate through your 
file system on your computer and choose a Template file to import. 

2. Select the desired Template file and click on "Open". The Template will be loaded 
and appended to your Template List. 
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4 Basic Concepts 
In this chapter we will introduce you to the basics of the Controller Editor. You might have 
already checked the previous chapter, which gives you a first idea of how to use the Con-
troller Editor. Here, we will approach the system in a more general way. 

4.1 How the Controller Editor Works 
The Controller Editor allows you to define the links between your NI Controller and the au-
dio applications running on your computer or your external MIDI devices. It lets you decide 
how your actions on the NI Controller will be interpreted. For this purpose, the Controller 
Editor implements a powerful mapping system allowing you to define as many MIDI as-
signments as you want for each Knob, Pad or Button available on your NI Controller. 
The Controller Editor works in conjunction with a small background service installed on 
your computer during the Controller Editor installation procedure. This background service 
takes care of all communication matters between your NI Controller and your MIDI-capa-
ble targets, both on the software side and on the hardware side. It stays alive even if you 
close the Controller Editor application. This especially means that you don't necessarily 
need to have the Controller Editor open on your computer to use your NI Controller as a 
MIDI remote control! You can select and/or tweak your assignments in the Controller Edi-
tor and then quit the application—the assignments (and Templates / Knob Pages / Pad Pa-
ges, see below) stay active thanks to this small background service. Thus, the Controller 
Editor can be seen as an assignment editor: use it to check or edit your assignments. 

4.2 Overview of the User Interface 
Let us have a closer look at the Controller Editor user interface now. When you bring the 
Controller Editor to the front in your operating system, you can see something like this: 
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Fig. 4.1. The Controller Editor user interface: the big view (Windows version pictured, with the MASCHINE 
Controller in the Hardware area). 

The user interface is divided into four main areas, namely: 
1. Application Menu Bar 
2. Application Control Bar 
3. Hardware area 
4. Inspector 
In the following sections you will find a brief introduction to all areas of the software and 
their corresponding control elements. For a detailed description of each of these elements, 
please refer to chapter 110, Reference. 
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4.2.1 Application Menu Bar 

At the top of the Controller Editor window (or at the top of your computer screen on Mac 
OS® X), the Application Menu Bar is similar to the one found in most applications on your 
operating system. It consists of three menus (File, View and Help) controlling the general 
functions of the software: 

6le I reW belP 

Fig. 4.2. The Application Menu Bar. 

The Controller Editor's Application Menu Bar with its three menus (Windows version pic-
tured). 

4.2.2 Application Control Bar 

Right under the Application Menu Bar, the Application Control Bar holds menus and but-
tons controlling the overall mapping system: 

Fig. 4.3. The Application Control Bar. 

From left to right, we have the following controls: 
1. Device menu: allows you to switch to another Controller and states which Controller 

you are currently working with. 
2. Connect button: allows you to "call" your hardware—in other words, to switch it to 

MIDI Mode and connect it to the Controller Editor, in case it is currently connected to 
its dedicated software. 

3. Template Select menu: allows to select the desired Template (Templates are explained 
in the next section, '4.3, The Mapping System). 

Controller Editor - Operation Manual - 30 

EFTA_R1_00171 050 

EFTA01810152



Basic Concepts 
Overview of the User Interface 

4. Minimize/Expand View button (the little arrow): switches between two Views of the Con-
troller Editor, by hiding/showing the Hardware area. 

5. MIDI Activity Indicator: shows any incoming/outgoing MIDI data. 
6. NI Logo: opens the About dialog. 

4.2.3 Hardware Area 

Below the two previous bars, the left (and biggest) part of the user interface holds the 
Hardware area. The Hardware area basically represents your NI Controller and all its con-
trol elements—most of them are freely assignable to MIDI messages. 

O If the Controller Editor is reduced to a small column on your screen, it means that the 
Hardware area is hidden. To show it, click on the Minimize/Expand View button (the little 
arrow) in the Application Control Bar above. 

The Controller depicted in the Hardware area depends on the device selected in the Device 
menu located in the Application Control Bar (see above). 
Compared to your real NI Controller, the Hardware area holds a few additional graphical 
elements: 
• Every control element that can be assigned to a MIDI message comes with a Label 

Field which displays a name describing its current assignment. 
• A red Selection Frame highlights the currently selected control element. 
• An orange Knob Page menu allows you to select a particular Knob Page of assign-

ments (see section '4.3. The Mapping System for more info on this). The Knob Page 
area, denoted by an orange frame, holds the control elements affected by the Knob 
Page selection in the Knob Page menu. 

M The Knob Page feature is not available on the RIG KONTROL 3. 

• MASCHINE Controller only: If the Pad Page feature is activated, an additional blue 
Pad Page menu allows you to select a particular page of assignments for the Pads. 
The blue frame highlights the Pad Page area, which holds the control elements in-
cluded in the Pad Pages—namely the Pads. Please refer to section ' 4.3.3. Pad Pa-
ges (MASCHINE Controller only) for more info on this. 
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You will find a detailed description of each Hardware area / NI Controller and its assigna-
ble control elements in the respective Controller-specific chapters, later in this manual. 

4.2.4 Inspector 

At the right of the Hardware area, the Inspector is the control tower of your mapping sys-
tem. There, you can precisely define what has to be done on your target when you press or 
turn anything on your NI Controller. Moreover, you can organize all your assignments into 
Knob Pages, Pad Pages (for the MASCHINE Controller) and Templates. Section - 10.4. 
The Inspector of the reference chapter will give you a detailed description of all what you 
can do with the Inspector. 
The Inspector is divided into three tabs, each of them controlling a specific part of the 
mapping scheme: the Templates tab, the Pages tab and the Assign tab. 

The Templates Tab 
The Templates tab allows you to manage your Templates. It shows a list of available Tem-
plates along with a few editing functions. 

O A Template holds a whole mapping configuration for all control elements of your NI Con-
troller. For more info, please read section ' 4.3 4. Templates below. 
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Fig. 4.4. The Templates tab in the Inspector (here for the MASCHINE Controller). 

The Templates tab holds the following elements, from top to bottom: 
1. Templates List: shows all available Templates with, for each Template, an index num-

ber (not editable) and a name (editable). There, you can select a Template for editing 
by clicking on its name, and modify its name by double-clicking on it (You can also 
select a Template via the Template Select menu in the Application Control Bar, or 
possibly from your NI Controller). 

2. Template Edit menu: provides you with editing functions like New, Save As, etc. 
3. Template Properties area: gives you access to the properties of the Template that is 

currently selected in the upper Template List. 

El There is no Template Properties area for the TRAKTOR KONTROL Xl. 
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The Pages Tab 
The Pages tab allows you to manage your Pages. This feature is not available on the RIG 
KONTROL 3—if you are currently working on a Template for the RIG KONTROL 3, you 
cannot activate the Pages tab. 
When working with the MASCHINE Controller, if the Pad Pages button of this tab is acti-
vated, you can also manage your Pad Pages here. 

O A Knob Page/Pad Page is a set of assignments for the control elements located in the 
Knob Page area or for the Pads (MASCHINE Controller only), respectively. For more info, 
please read section M.3, The Mapping System. 
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Fig. 4.5. The Pages tab in the Inspector for the MASCHINE Controller. 

The Pages tab holds the following elements: 

Controller Editor - Operation Manual - 35 

EFTA_R1_00171055 

EFTA01810157



Basic Concepts 
Overview of the User Interface 

1. Knob Page List: shows a list with all available Knob Pages with, for each of them, an 
index number (not editable) and a name (editable). There, you can select a Knob 
Page for editing by clicking on its name, and modify its name by double-clicking on 
it. On the MASCHINE Controller and KORE Controllers, you can rearrange the Knob 
Pages' order via drag&drop (You can also select a Knob Page via the Knob Page menu 
above the Knob Page area, or possibly from your NI Controller). 

2. Knob Page Edit menu: provides you with editing functions like New, Duplicate, etc (For 
the TRAKTOR KONTROL X1 and the AUDIO KONTROL 1, this Edit menu is replaced 
with a Shift Mode menu with the two options Gate and Toggle, allowing you to choose 
the behaviour of the Shift Button when switching between Knob Pages from your con-
troller. See section 1 7.2.1. Switching Between Knob Pages (TRAKTOR KONTROL 
X1) and ' 9.2. Special Control Elements (AUDIO KONTROL 1) for more info on this.). 

3. Pad Pages button: activates/deactivates the Pad Page feature. If the Pad Page feature 
is deactivated, the rest of the area is grayed out and won't react to user action. 

4. Pad Page List: shows a list with all available Pad Pages with, for each of them, an in-
dex number (not editable) and a name (editable). There, you can select a Pad Page 
for editing by clicking on its name, and modify its name by double-clicking on it. You 
can rearrange the Pad Pages' order via drag&drop (You can also select a Pad Page via 
the Pad Page menu above the Pads, or with the Groups Buttons labeled A to H in the 
Hardware area and on your MASCHINE Controller). 

5. Pad Page Edit menu: provides you with editing functions, like New, Duplicate, etc. 

m Buttons 3 to 5 are available if you are working on the assignments for the MASCHINE 
Controller. 

The Assign Tab 
The last tab in the Inspector is the Assign tab. This is where you specify all details of the 
assignment for a particular control element. This tab shows the properties of the currently 
selected control element: 
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Fig. 4.6. The Assign tab in the Inspector. 

The Assign tab shows different properties depending on the type of element currently se-
lected. 
1. Description area: this area is common to all control elements. It shows the following 

information about the currently selected control element: The index number and the 
name of the Knob Page or Pad Page of the selected control element (this is empty for 
the elements not included in a Knob Page / Pad Page). The element description (not 
editable) and its name (editable). 

2. Properties area: holds the MIDI assignment properties for the current control element. 
Please refer to section ' 10.4.3. The Assign Tab in the reference chapter for a de-
tailed explanation of all these properties. 
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4.3 The Mapping System 
Whatever you do on your NI Controller, the Controller Editor translates it into a MIDI mes-
sage that is then sent to the desired MIDI port—this is what the Controller Editor is all 
about: mapping human actions to MIDI events. 
The Controller Editor's mapping system is structured in a way that allows you to efficiently 
organize your assignments. This makes the whole mapping process a lot easier and in-
forms you about what will happen whenever you actuate a control element on your NI Con-
troller. The next paragraphs will introduce you to some basic concepts. 

4.3.1 Assignments 
An Assignment defines which MIDI event is triggered by a particular control element. 
Available MIDI event types are "MIDI Note-On", "MIDI CC", etc. Every action on a control 
element is translated into one MIDI event, the corresponding assignment defining the 
rules of that translation. 
Depending on the type of control element (button, knob, pad, pedal input, footswitch...), 
the available assignments will differ. For more details about all available assignments for 
each type of control, please refer to chapter 10, Reference. 

4.3.2 Knob Pages (MASCHINE Controller, KORE Controllers, TRAKTOR KONTROL X1 and 
AUDIO KONTROL 1) 

For some of the control elements, you can have multiple assignments, stored on so-called 
"Knob Pages." Those particular control elements are located in the Knob Page area (the 
orange frame, see section *4.2.3. Hardware Area above). A Knob Page is a set of assign-
ments for all control elements in this Knob Page area. One Knob Page can be selected 
(and loaded) at a time. 

O On the KORE Controller, the Knob Pages are the MIDI equivalent to the Control Pages in 
the KORE 2 software. 
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You can switch the available Knob Pages (either built-in or user-defined) via the Knob 
Page menu in the Hardware area or via the Knob Page List in the Inspector (see section 
14.2, Overview of the User Interface above for a brief description of the interface). You 
can do it as well from your NI Controller—more on this in the respective chapters describ-
ing how to use each NI Controller. 
When you select another Knob Page, all assignments for the control elements in the Knob 
Page area are updated accordingly. All Knob Pages are stored as an editable list on the 
Pages tab in the Inspector (for detailed information about the Inspector, please refer to 
section r 10.4. The Inspector). 

4.3.3 Pad Pages (MASCHINE Controller only) 
On the MASCHINE Controller, you also have access to a similar (but optional) paging sys-
tem dedicated to the Pads: the Pad Pages. The Pad Pages work like the Knob Pages ex-
plained above, but they affect the sixteen Pads instead of the Knob Page area's knobs and 
buttons. 
Unlike the Knob Pages, which can be as many as you want, the number of Pad Pages is 
limited to eight. One Pad Page can be selected at a time. 
The Pad Pages can be activated or deactivated, depending on your needs, via the Pad Pa-
ges button in the Inspector's Assign tab. If activated, you can switch the available Pad Pa-
ges via the Pad Page menu or the eight Group Buttons in the Hardware area, or via the 
Pad Page List in the Inspector. Again, you can do it as well from your NI Controller, via the 
same Group Buttons (labeled from A to H). 
When you select another Pad Page, all assignments for the sixteen Pads are updated ac-
cordingly. The eight available Pad Pages are stored as an editable list on the Pages tab in 
the Inspector (you will find all details about the Inspector in section 10.4, The Inspec-
tor). 

4.3.4 Templates 
A Template holds a mapping configuration for all control elements on your NI Controller, 
including the Knob Pages and Pad Pages that might exist. One Template can be selected 
at a time. The Template also determines if the generated MIDI events have to be sent to 
the internal MIDI port (to access an application listening to MIDI on your computer) or to 
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the external MIDI port (to access an external MIDI-capable device)—only for Controllers 
that are equipped with MIDI ports of course. Switching between different Templates can 
be used, for example, to address different applications on your computer or different hard-
ware instruments. 
The Template contains all Knob Page/Pad Page data, the list of Knob Pages/Pad Pages 
and the index of the last selected Knob Page/Pad Page. The Template also stores the last 
state of each control element. 
The Templates can be stored as distinct files on your computer. These files have the ex-
tension ".ncm" (for the MASCHINE Controller), ".nck" (for the KORE Controller), ".nckxl" 
(for the TRAKTOR KONTROL X1), ".ncg" (for the RIG KONTROL 3) or ".nckl" (for the 
AUDIO KONTROL 1). 
You can switch among the available Templates (either built-in or user-defined) via the 
Template Select menu in the Application Control Bar or via the Template List in the In-
spector. This can also be done from some NI Controllers—more on this in the respective 
chapters describing how to use each NI Controller. 
When you select another Template, all assignments for all control elements of the inter-
face are updated accordingly, including the Knob/Pad Pages. All Templates are stored as 
an editable list on the Templates tab in the Inspector (see section 10.4. The Inspector in 
this manual). 

4.3.5 Configuration 
For each NI Controller, the working set of data contains the current list of Templates, all 
data of the Templates in the list, and the index of the currently selected Template. 
The group of all data sets is automatically stored as a single Configuration file on your 
computer. This type of file has the extension ".ncc." This Configuration file is automatical-
ly loaded by the Hardware Controller Support background service as soon as you start your 
computer. 

4.4 To sum up... 
By utilizing your NI Controller and the Hardware Controller Support (the Controller Editor 
and the NI background service) you can remote-control any MIDI target. The Hardware 
Controller Support was designed in a way that allows you to forget its presence in a live 
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situation: after having configured your assignments, you can rely on your NI Controller to 
control everything you need during your performance. Triggering MIDI hardware devices 
and applications in various ways, switching in real time to other sets of assignments (ex-
cept for the RIG KONTROL 3)... all this can be done directly from your NI Controller. 
Actually, the only thing that you can not do from the Controller is modify your assign-
ments... For that, you will need to use the Controller Editor! But thanks to the powerful 
mapping scheme using Templates, Knob Pages and Pad Pages, which is partly mirrored on 
your NI Controller, you can prepare as many assignments as you want and recall them in-
stantly during your live performance. 
In the next chapters, we will show you how to use your Controller(s) with the assignments 
defined within the Controller Editor. 
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5 Using your MASCHINE Controller 
In this chapter, we will focus on what's happening on your MASCHINE Controller. We will 
first list all assignable control elements on your controller, then describe how the various 
luminous elements give you some important information about their state, and we will fi-
nally describe thoroughly the powerful Displays of your MASCHINE Controller. 

❑~-
To enjoy full functionality of your NI Controller as a MIDI remote control, especially con-
cerning some control elements' state and LED behaviour, you need to tell your NI Control-
ler what is the current state of the parameter in the MIDI target. You can do this by set-
ting up MIDI feedback channels coming from your MIDI target back to your NI Controller. 
This way, your controller will always stay up-to-date with the current parameter values in 
your target software/hardware. For more info on how to configure these MIDI feedback 
channels, please refer to your target software/hardware's documentation. 

5.1 Assignable Control Elements 
If you selected the MASCHINE Controller in the Application Control Bar's Device menu, 
here is how the Hardware area looks like: 
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The Hardware area representing the MASCHINE Controller, with the Knob Page menu and 
its associated Knob Page area (orange frame), the Pad Page menu and its associated Pad 
Page area (blue frame), and the Selection Frame (red) on the currently selected control el-
ement (here the Volume Knob). 
The MASCHINE Controller interface holds the following areas: 

M The names that you see on many control elements only refer to their original function in 
the MASCHINE software. We use these names here only to describe the interface! 

1. Page Buttons: In the top left part, you find a set of eight buttons arranged into four 
rows of two buttons. From these eight buttons, six are freely assignable (Control and 
Step, Browse and Sample, Snap (F1) and Autowrite (F2)) and two have a specific 
function: the Previous and Next Buttons, showing little orange left/right arrows. 
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2. Knob Page area: The Knob Page area holds a set of eight buttons and eight knobs, 
with the buttons being placed above and the knobs being placed below the two Dis-
plays. These sixteen control elements are freely assignable. The Knob Page area is 
headed by the Knob Page menu. 

3. Pad Page area: The Pads area shows a column of eight freely assignable buttons 
(namely Scene, Pattern, Keyboard, Navigate, Duplicate, Select, Solo and Mute) as 
well as a square of sixteen freely assignable Pads, grouped in the so-called Pad Page 
area. If the Pad Pages button is activated in the Pages tab of the Inspector, these 
Pads are headed by the Pad Page menu and you can switch between different sets of 
assignments for the Pads. 

4. Master area: The Master area holds four freely assignable control elements (three 
knobs and one button). 

5. Groups area: The Groups area contains eight buttons labeled from A to H: the Group 
Buttons. If you activated the Pad Pages button in the Inspector, these buttons allow 
you to select the desired page of assignments for the Pads (see next section). If you 
didn't activate the Pad Pages, these eight buttons are freely assignable to MIDI 
events. 

6. Transport area: The Transport area contains eight buttons. Seven of them are freely as-
signable (Restart - which is Loop on older controllers — , Prey, Next, Grid, Play, Re-
cord and Erase). The last one, Shift, is a special button (more on this in the next sec-
tion). Therefore, this button cannot be assigned in the Controller Editor interface it-
self. 

To sum up, the control elements of the MASCHINE Controller are freely assignable to any 
MIDI event (with the limitations due to the type of control element), with the following ex-
ceptions: 
• The Page Buttons and the Shift Button have a predefined function. 
• The Group Buttons of the Groups area, labeled A to H, are not assignable if you use 

the Pad Page feature. If you deactivate this feature, these eight buttons are freely as-
signable like any other. 

The functions of these special Buttons are explained in the next section. 
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5.2 Special Control Elements 
Your MASCHINE Controller has following special control elements: the Page Buttons and 
the Shift Button. 

5.2.1 Switching Between Knob Pages or Templates 

• To switch between Knob Pages from your MASCHINE Controller, use the Page But-
tons. 

• To switch between Templates from your MASCHINE Controller, hold the SHIFT But-
ton depressed and use the Page Buttons. 

5.2.2 Switching Between Pad Pages 

If the Pad Page functionality is activated, you can switch between Pad Pages from your 
MASCHINE Controller: 
• To switch between Pad Pages from your MASCHINE Controller, use the Group But-

tons A-H. 
As a reminder: the Pad Pages are additional sets of assignments for the Pads of your MA-
SCHINE Controller. You can activate them by enabling the Pad Pages button on the Pages 
tab of the Inspector. 

5.2.3 Switching Between MIDI Mode and MASCHINE Mode 

• To switch your MASCHINE Controller between MIDI Mode and MASCHINE Mode, 
hold the SHIFT Button depressed and press the CONTROL Button. 

As a reminder: in MIDI Mode your MASCHINE Controller triggers MIDI events, whereas in 
MASCHINE Mode it controls its dedicated software MASCHINE. 

5.2.4 Other Features of the SHIFT Button 

The SHIFT Button also allows you to switch to another Display Mode, giving you access to 
several other features on your MASCHINE Controller. Please read the section ' 5.4. The 
Displays for more info in this. 
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5.3 The Status LEDs 
Many control elements on your MASCHINE Controller are equipped with LEDs that inform 
you about the assignment status of the control elements in real time. The fast bidirection-
al communication between your MASCHINE Controller and the Hardware Controller Sup-
port on the software side allows updating in real time all status indications on your NI 
Controller. 
The LEDs below each control element can have three states: off, low brightness and high 
brightness. Their lighting behavior depends on the type and status of the control element. 

5.3.1 Buttons 

Here are the rules for the Buttons on your MASCHINE Controller: 
• If the Button is not assigned, the LED is completely dark. 
• If the Button is assigned and in Toggle Mode, the LED has a low brightness to show 

the Off state and a high brightness to show the On state. 
• If the Button is assigned and in Trigger or Gate Mode, the LED behaviour is controlled 

by the MIDI target via a MIDI feedback channel: the MIDI target can send a MIDI 
message back to the controller that will define the LED's state. 

• If the Button is assigned and in Increment Mode, the LED stays at low brightness. 

O For more info on the various Button Modes, please refer to section - 10.4.3. The Assign 
Tab in the reference chapter. 

• Moreover, for the eight Buttons above the Displays, the particular assignment is 
shown within the Displays in Knobs Display Mode (see section '5.4.2, Knobs Display 
Mode below). 

5.3.2 Knobs 
Here are the rules for the Knobs on your MASCHINE Controller: 
• The assignments for the eight Knobs under the Displays are indicated within these 

Displays in Knobs Display Mode (see section 5.4.2, Knobs Display Mode below). If 
a Knob is not assigned, the Display reads Off. 
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• The Volume, Tempo and Swing Knobs in the Master area have no display, but, like for 
all other controls, their value is shown in the Displays in the Event line of the Monitor 
Mode. 

5.3.3 Pads 

Here are the rules for the Pads on your MASCHINE Controller. Since the Pads have two 
functions (they are pressure-sensitive), the states are indicated as follows: 
• If the Pad is not assigned, its LED is completely dark. 
• If there is an assignment for the Hit action, the behaviour is the same as for the But-

tons above. 

O For more info on the various Button Modes, please refer to section 110.4.3, The Assign 
Tab in the Reference chapter. 

• If there is no assignment for the Hit action but an assignment for the Press action to 
the Note message type, the LED has a low brightness to show the Off state and a high 
brightness to show the On state. For all other message types, the LED stays at low 
brightness. 

5.4 The Displays 
The Displays can show different parts of your mapping configuration, depending on the 
Display Mode that is activated. Each Display Mode modifies the behavior of the upper but-
ton row and lower knob row. Learn more about the different Display Modes available for 
the MASCHINE Controller's displays in the following sections. 

5.4.1 Switching Between Display Modes 

First of all, to switch between Display Modes, press the SHIFT button on your MASCHINE 
Controller and hold it. On the Displays, you see something like this: 
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Fig. 5.1. The displays on your MASCHINE Controller with the SHIFT button depressed. 

This screen allows you to select the desired Display Mode. On the top, you find six fields 
representing the six Display Modes. The six modes are, from left to right: Monitor, Set-
tings, Knobs, Pads, Page and Template. 
• To switch to any of the Display Modes, hold the SHIFT Button depressed and press 

the corresponding Button in the row above the Displays. 
At any time, you can press the SHIFT button again and switch to another Display Mode. 
In the middle part of the left Display, you see the currently loaded Template. This is com-
mon to all Display Modes (except the Settings Display Mode), so that you can always be 
sure about which Template is currently selected. 
Below, a message reminds you that you can switch to another Template simply by pressing 
the Page Buttons (since you are already pressing the SHIFT Button). 

5.4.2 Knobs Display Mode 
The Knobs Display Mode is probably the one you will use the most. This is also the default 
Display Mode: as soon as your MASCHINE Controller switches to MIDI Mode (either by 
pressing SHIFT + CONTROL (MIDI) on your NI Controller, or by clicking on the Connect 
button in the Controller Editor's Application Control Bar, or automatically when you start 
your computer/the Controller Editor), the Displays switch to the Knobs Display Mode. 
In this mode, the Displays show the currently loaded Knob Page, with its eight button as-
signments on the top row and its eight knob assignments on the bottom row: 

MICITS 
TEMPLATE' 02 - TEMPLATE 2 

02an ID= ID2ZECI 
KNOB PAGE 01 - PAGE 1 
PRDPAGB - GROUP 2 

CC AY CC XS CC SS CC SW CC l• CC LS CC 20 CC al 
51 25 76 60 50 59 43 100 

Fig. 5.2. The Knobs Display Mode mirrors the currently loaded Knob Page. 
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This Display Mode allows you to see which MIDI message is currently assigned to each 
control element in the loaded Knob Page. In this mode, the 16 control elements around 
the Displays (8 upper buttons and 8 lower knobs) trigger the assigned MIDI messages. 
Each field mirrors the Label Field as defined in the Inspector's Assign tab for the corre-
sponding control element: the name you defined there appears here—if you haven't de-
fined any name yet for that control element, its label is simply its assigned MIDI message. 
In the lower row, the Displays additionally show the current value for each knob. These 
values can be displayed in two views: either via numerical values (like in the picture 
above), or via small bars: 

Sei•ZT,M1 Mg•M Imo) 195ant 
tEkkATE: '' TEMPLATE 2 

afitta 
KNOB PAGE. 01 - PAGE 1 
PAD PAGE - 8 - GROUP 2 

M 1.14471 

CC LS CO LS CO LS CC 17 CC XS CC XS CC 20 CC al 

Fig. 5.3. The Knobs Display Mode with bars instead of numerical values. 

You can switch between the two views by pressing the Shift button and turning the 5th 
Knob to the left or to the right: 
1. Press the Shift Button (thus getting to the switching screen explained above). 

You can see the option Show Bars or Show Values above the 5th Knob (depending on 
which view is currently selected). 

2. Turn this 5th Knob to select the desired view. 
3. Release the Shift Button, and the new view is displayed. 
Note that, depending on the assignment properties for each of the knobs, its displayed val-
ue (or bar) can either be going from 0 to 127 or from -64 to 63 (bipolar)—this second 
setting can be useful for some types of controls (e.g. a stereo balance). Please refer to sec-
tion 1 9.4.3. The Assign Tab for more info on this. 

5.4.3 Pad Pages Display Mode 
The Pad Pages Display Mode (labeled "Pads" on the Displays) allows you to check the cur-
rent assignations for the Pads of your MASCHINE Controller, by mirroring the currently 
loaded Pad Page: 
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Fig. 5.4. The Pad Pages Display Mode mirrors the currently loaded Pad Page. 

On the left Display, you find some general info about the currently loaded Template, Knob 
Page and Pad Page. The right Display summarizes the Pads' assignments stored in the ac-
tive Pad Page. 

5.4.4 Knob Pages Display Mode 

The Knob Pages Display Mode allows you to switch between Knob Pages: 

Fig. 5.5. The Knob Pages Display Mode allows you to switch between Knob Pages. 

On the left Display, you find the usual general info about the currently loaded Template, 
Knob Page and Pad Page. 
On the right Display, you see the list of your Knob Pages, as defined in the Knob Page List 
of the Inspector's Pages tab. 
1. Use the two Buttons above the up and down arrows to scroll through the list and find 

the Knob Page you wish to load next. 
2. When you have it, press the last Button (labeled Load) to load the selected Knob 

Page. 
Actually, this functionality is already available in many ways: in the Controller Editor, you 
can use the Knob Page menu (in the Hardware area) or the Knob Page List (in the Inspec-
tor's Pages tab), and on the MASCHINE Controller you have the Page Buttons at your dis-
posal. But the Knob Pages Display Mode allows you a greater control over the Knob Page 
selection from within the MASCHINE Controller: 
• Unlike the Knob Page menu and Knob Page List, you don't have to open the Control-

ler Editor to switch to another Knob Page. 

Controller Editor - Operation Manual - 50 

EFTA_R1_00171 070 

EFTA01810172



Using your MASCHINE Controller 
The Displays 

• Unlike the Page Buttons on your MASCHINE Controller, you can quietly choose the 
next Knob Page to be loaded, even if it's not the one right after/before the currently 
loaded Knob Page. You can check its name to remember its assignments, and you 
can scroll the entire list to find the page you want. 

5.4.5 Template Display Mode 

The Template Display Mode allows you to switch between Templates. 

Fig. 5.6. The Template Display Mode allows you to switch between Templates. 

On the left Display, you find the same general info about the currently loaded Template, 
Knob Page and Pad Page. 
On the right Display, you see the list of your Templates, as defined in the Inspector's Tem-
plates tab. 
1. Use the two buttons above the up and down arrows to scroll through the list and find 

the Template you wish to load next. 
2. When you have it, press the last button (labeled Load) to load the selected Template. 
Like for the Knob Pages, this functionality is already available in many ways: in the Con-
troller Editor, you can use the Template Select menu (in the Application Control Bar) or 
the Template List (in the Inspector's Templates tab), and on the MASCHINE Controller 
you have the Page Buttons at your disposal. The Template Display Mode allows you a 
greater control over the Knob Page selection from within the MASCHINE Controller 
though, for the same reasons as those we explained in the previous section for the Knob 
Pages. 

5.4.6 Monitor Display Mode 

The Monitor Display Mode provides you with useful information about the MIDI data sent 
by your MASCHINE Controller. 
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Fig. 5.7. The Monitor Display Mode provides information about the MIDI data sent by your MASCHINE Con-
troller. 

The left Display shows the usual info about the current Template, Knob Page and Pad 
Page. 
The right Display shows two lines: 
• The line Control displays the control element that you are currently actuating. 
• The line Event shows the details of the MIDI event being currently sent by this control 

element. 
This Display Mode is very useful to monitor what's going out from your MASCHINE Con-
troller, for example for debugging purpose: if something goes wrong somewhere in your 
MIDI chain, you can check here what is actually sent by your MASCHINE Controller. 

5.4.1 Settings Display Mode 

The Settings Display Mode allows you to adjust relevant parameters and provides informa-
tion about your MASCHINE Controller. 

Fig. 5.8. The Settings Display Mode provides access to parameters for your MASCHINE Controller. 

The settings are grouped in the left Display. They are the same as in the Controller tab of 
the Preferences window (when the MASCHINE Controller is selected in the Controller 
menu at the top, of course). The settings are: 
• Brightness: changes the backlight of the displays. 
• Pad Sensitivity: changes the sensitivity of the Pads. 
• Contrast L: sets the contrast for the left Display. 
• Contrast R: sets the contrast for the right Display. 

Controller Editor - Operation Manual - 52 

EFTA_R1_00171072 

EFTA01810174



Using your MASCHINE Controller 
The Displays 

The right Display provides you with some important information about your MASCHINE 
Controller and the Hardware Controller Support service: 
• In the upper part, you find the firmware version of your MASCHINE Controller along 

with its serial number. 
• Below, you see the version numbers of the NI Hardware Service and hardware drivers. 
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6 Using your KORE Controller 
In this chapter you will learn how to use your KORE Controller in conjunction with the 
Controller Editor software. We will first list all assignable control elements on your control-
ler, then describe how the various luminous elements inform you about their state and fi-
nally proceed to the various Display Modes. 

rn To enjoy full functionality of your NI Controller as a MIDI remote control, especially con-
cerning some control elements' state and LED behaviour, you need to tell your NI Control-
ler what is the current state of the parameter in the MIDI target. You can do this by set-
ting up MIDI feedback channels coming from your MIDI target back to your NI Controller. 
This way, your controller will always stay up-to-date with the current parameter values in 
your target software/hardware. For more info on how to configure these MIDI feedback 
channels, please refer to your target software/hardware's documentation. 

6.1 Assignable Control Elements 

6.1.1 KORE 2 Controller 

If you selected the KORE 2 Controller in the Application Control Bar's Device menu, here 
is how the Hardware area looks like: 

Controller Editor - Operation Manual - 54 

EFTA_R1_00171074 

EFTA01810176



Using your KORE Controller 
Assignable Control Elements 

The Hardware area representing the KORE 2 Controller, with the Knob Page menu and its 
associated Knob Page area (orange frame) and the Selection Frame (red) on the currently 
selected control element (here Controller Knob #1). 
The KORE 2 Controller interface holds the following areas: 

M The names that you see on many control elements only refer to their original function in 
the KORE 2 software. 

1. Knob Page area: The Knob Page area holds a set of eight buttons and eight knobs, 
representing the eight Controller Buttons and eight Controller Knobs of your KORE 
Controller. These sixteen control elements are freely assignable. The Knob Page area 
is headed by the Knob Page menu. 

2. Pedal area: The Pedal area holds four freely assignable control elements correspond-
ing to the two Pedal Inputs and the two Footswitch Ports. 

3. Left/Right and Up/Down Arrow Buttons: In the central part of the KORE 2 Controller 
view, the four Arrow Buttons have specific functions (see next section). 
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4. Scrollwheel and surrounding Buttons: In the right part, the Scrollwheel and the sur-
rounding four buttons (namely Control, Sound, Esc and Enter on your KORE 2 Con-
troller) define five freely assignable control elements. The two other buttons, Fl and 
F2, have predefined functions and therefore cannot be assigned to any MIDI com-
mand (see section I 6.2. Special Control Elements). 

5. Transport area: The Transport area contains four buttons (Stop, Start, Record and Pre-
Listen). All of them are freely assignable. 

To sum up, all control elements of the KORE 2 Controller are freely assignable to any MIDI 
event (with the limitations due to the type of control element), with the following excep-
tions: 
• The four Arrow Buttons. 
• The Fl and F2 Buttons. 
The functions of these special Buttons are explained in section r 6.2, Special Control Ele-
ments below. 

6.1.2 KORE 1 Controller 
The KORE 1 Controller is very similar to the KORE 2 Controller. Regarding MIDI remote 
control, these are the differences: 
• In the Pedal area, there is only one pedal input instead of two. 
• The Buttons around the Scrollwheel have slightly different layout and names: If the 

four freely assignable Buttons are exactly the same as on the KORE 2 Controller, the 
two function Buttons are called View (instead of Fl) and Menu (instead of F2) and 
laid out vertically instead of horizontally around the Scrollwheel. But since these But-
tons are not assignable, it won't change much for us. If you own a KORE 1 Controller, 
simply think "View" when we say "Fl" and "Menu" when we say "F2." 

6.2 Special Control Elements 
Your KORE Controller has following special control elements: the four Arrow Buttons and 
the Fl and F2 Buttons (or View and Menu on the KORE 1 Controller). 

Controller Editor - Operation Manual - 56 

EFTA_R1_00171076 

EFTA01810178



Using your KORE Controller 
The Status LEDs 

6.2.1 Switching Between Templates or Knob Pages 

• To switch between Knob Pages from your KORE Controller, use the Up/Down Arrow 
Buttons. 

• To switch between Templates from your KORE Controller, press the Fl Button and 
use the same Up/Down Arrow Buttons. 

6.2.2 Switching Between MIDI Mode and KORE Mode 

• To switch your KORE Controller between MIDI Mode and KORE Mode, press the Fl 
Button followed by the Control Button. 

As a reminder: in MIDI Mode your KORE Controller triggers MIDI events, whereas in KORE 
Mode it controls its dedicated software KORE 2. 

6.2.3 Other Features 

The Fl and F2 Buttons (or View and Menu on the KORE 1 Controller) also allow you to 
switch to another Display Mode, giving you access to several other features on your KORE 
Controller. The Left and Right Arrow Buttons are also used in conjunction with the Display. 
Please refer to section 16.4, The Display for more info on this. 

6.3 The Status LEDs 
Almost all control elements on your KORE Controller are equipped with LEDs that inform 
you about the assignment status of the control elements in real time. The fast bidirection-
al communication between your KORE Controller and the Hardware Controller Support on 
the software side allows updating in real time all status indications on your KORE Control-
ler. 

6.3.1 Buttons 

Here are the rules for the Buttons on your KORE Controller: 
• If the Button is not assigned, the LED is completely dark. 
• If the Button is assigned and in Toggle Mode, the LED is off to show the Off state and 

lit to show the On state. 
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• If the Button is assigned and in Trigger or Gate Mode, the LED behaviour is controlled 
by the MIDI target via a MIDI feedback channel: the MIDI target can send a MIDI 
message back to the controller that will define the LED's state. 

• If the Button is assigned and in Increment Mode, the LED stays off. 

O For more info on the various Button Modes, please refer to section 110.4.3. The Assign 
Tab in the reference chapter. 

The assignments for the Controller Buttons (i.e. the Buttons arranged in two lines above 
and below the Controller Knobs) are indicated within the Display of your KORE Controller 
in Control Display Mode (see section f 6.4.2, Control Display Mode). If one of these But-
tons is not assigned, the Display reads Off. 

6.3.2 Knobs 
Here are the rules for the Controller Knobs on your KORE Controller: 
• If the Controller Knob is not assigned, the LED ring around it is completely dark. 
• If the Controller Knob is assigned, the LED ring's brightness reflects the MIDI value, 

relatively to the range of values defined for this Controller Knob. 
The assignments for the Controller Knobs along with their current value are indicated with-
in the Display of your KORE Controller in Control Display Mode (see section ' 6 4 2. Con-
trol Display Mode). If a Controller Knob is not assigned, the Display reads Off. 

6.3.3 Scrollwheel 
Regarding its LED ring's behavior, the Scrollwheel of the KORE Controller behaves like the 
Controller Knobs (see above for more info). 
It is not possible to see the assignment for the Scrollwheel on your hardware: you need to 
look at the Controller Editor window. 

6.3.4 Pedal Inputs and Footswitch Ports 
Obviously, Pedal inputs and Footswitch ports don't have any LED! 
There is no way to see their assignment on your hardware: to do this, you have to check 
the Controller Editor window. 
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6.4 The Display 
On your KORE Controller, the Display can show useful information, thus allowing you to 
adjust different parameters. In this way you do not have to open the Controller Editor on 
your computer while working with your KORE Controller. 
The Display can show different parts of your mapping configuration, depending on the Dis-
play Mode that is activated. The five available Display Modes are: Control, Knob Pages, 
Templates, Setup and Options. In each Display Mode, the Display Header (at the top of 
the Display) always reminds you of the current Display Mode. 
The following sections describe each of these Display Modes. 

6.4.1 Switching between Display Modes 

The selection of a particular Display Mode is mainly done via the F2 Button. 
• Press the F2 Button to show the Overview Screen on your Display: 

To view the Overview Screen on the Display of your KORE Controller, press F2. 
This screen allows you to select the desired Display Mode. The available Display Modes 
are presented in a matrix with two rows of four cells each, similar to the Sound Variations 
in the KORE Software. The four Display Modes available here are: 
• Knob Page (labeled PAGE) 
• Control (labeled CTL) 
• Setup (labeled SET) 
• Options (labeled OPTN) 
To switch to any of them, you can: 
• Navigate with the four Arrow Buttons (Up, Down, Left and Right) to put the target 

frame on the desired cell and press the Enter Button to confirm your choice. 
Or 
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• Press the corresponding Controller Button on your KORE Controller for a direct access 
to that Display Mode. You will notice that the Controller Buttons activating a particu-
lar Display Mode are judiciously lit, whereas those not doing anything stay dark. 

From this Overview Screen, you can also switch back to the previously selected Display 
Mode: 
• Press the Esc Button on your KORE Controller to switch back to the previously select-

ed Display Mode. 
At any time, you can press the F2 Button again to get to the Overview Screen and switch 
to another Display Mode. 

Exception: the Templates Display Mode 

To activate the Templates Display Mode: 
• Press the Fl Button (see section -6.4.6. Templates Display Mode below for more in-

fo on this mode). 

6.4.2 Control Display Mode 

The Control Display Mode is probably the one you will use the most. 
• To activate the Control Display Mode, press F2 (to show the Overview Screen) then 

the Button 2 or the Control Button. 

O You can also press F2 and use the Arrow Buttons to select the cell CTL on the Overview 
Screen, and subsequently press the Enter Button. 

In this mode, the Display shows the currently loaded Knob Page. By default, it displays 
the assignments for the eight Controller Buttons on the top and bottom rows, and the eight 
assignments for the Controller Knobs on the two middle rows: 
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The Control Display Mode mirrors the currently loaded Knob Page. This display mode al-
lows you to see which MIDI message is currently assigned to each control element in the 
loaded Knob Page. In this mode, the 8 Controller Buttons and 8 Controller Knobs of your 
KORE Controller trigger their assigned MIDI messages. 
The Display Header first shows CTL (to remind you that you are in the Control Display 
Mode), followed by the name of the currently loaded Knob Page. 
The Control Display Mode has three views, similar to those of the Control Display Mode 
when using the KORE Controller with the KORE 2 Software. 

All view 

All shows the Labels of all assigned parameters for all Controller Knobs and Buttons. As 
soon as you touch a Controller Knob on the hardware the Display Header shows the name 
of the parameter and its value. 

Potis view 

Potis is a mode that only displays the parameters assigned to the Controller Knobs of your 
NI Controller. In the top and bottom row, the values of the Knobs are displayed via meters. 

Single view 
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Single always displays the currently selected Controller Knob parameter's Label, Meter and 
Value. 
You can switch between the three views in the Options Display Mode (see section ' 6.4 5, 
Options Display Mode below for more info). 
Note that, depending on the assignment properties for each of the Knobs, its displayed 
value can either be going from 0 to 1 or from -1 to 1 (bipolar)—this second setting can be 
useful for some types of controls (e.g. a stereo balance). Please refer to section ' 9.4.3, 
The Assign Tab for more info on this. 

6.4.3 Knob Pages Display Mode 
The Knob Pages Display Mode allows you to switch between Knob Pages. 
• To activate the Knob Pages Display Mode, press F2 (to show the Overview Screen) 

then the Button 1. 

O You can also press F2 and use the Arrow Buttons to select the PAGE cell on the Overview 
Screen, and subsequently press the Enter Button. 

Fig. 6.1. The Knob Pages Display Mode allows you to switch between Knob Pages. 

On the Display, you see the list of your Knob Pages, as defined in the Knob Page List of 
the Inspector's Pages tab. 
1. Use the Scrollwheel to scroll through the list and find the Knob Page you wish to load 

next. 
2. Press the Enter Button on your KORE Controller to load the selected Knob Page. 

© The current assignments for the 8 Controller Buttons and 8 Controller Knobs stay active 
when the Knob Pages Display Mode is activated. 

Controller Editor - Operation Manual - 62 

EFTA_R1_00171082 

EFTA01810184



Using your KORE Controller 
The Display 

Actually, this functionality is already available in many ways: in the Controller Editor, you 
can use the Knob Page menu (in the Hardware area) or the Knob Page List (in the Inspec-
tor's Pages tab), and on the KORE Controller in Control Display Mode you have the Page 
Buttons at your disposal (the Up and Down Arrow Buttons). But the Knob Pages Display 
Mode provides extensive control over the Knob Page selection from within the KORE Con-
troller: 
• Unlike the Knob Page menu and Knob Page List, you don't have to open the Control-

ler Editor to switch to another Knob Page. 
• Unlike the Page Buttons on your KORE Controller, you can quietly choose the next 

Knob Page to be loaded, even if it's not the one right after/before the currently loaded 
Knob Page. You can check its name to remember its assignments, and you can scroll 
the entire list to find the page you want before to load any. 

6.4.4 Setup Display Mode 
The Setup Display Mode allows you to tweak settings for your KORE Controller. 
• To activate the Setup Display Mode, press F2 (to show the Overview Screen) then the 

Button 7. 

O You can also press F2 and use the Arrow Buttons to select the SET cell on the Overview 
Screen, and subsequently press the Enter Button. 

Fig. 6.2. The Setup Display Mode provides access to some parameters of your KORE Controller. 

The settings are the same as in the Controller tab of the Preferences window (when the 
KORE Controller is selected in the Controller menu at the top, of course). You will find 
these three parameters: 
• Contrast: Changes the contrast of the Display. 
• Backlight: Changes the background lighting of the Display. 
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• Touch Sens: Adjusts the touch-sensitivity of the eight Controller Knobs on your Con-
troller. 

You can use the four Arrow Buttons to select a particular parameter and modify its value. 

O The current assignments for the 8 Controller Buttons and 8 Controller Knobs stay active 
when the Setup Display Mode is activated. 

6.4.5 Options Display Mode 

• To activate the Options Display Mode, press F2 (to show the Overview Screen), then 
Button 8. 

O You can also press F2 and use the Arrow Buttons to select the OPTN cell on the Overview 
Screen, and subsequently press the Enter Button. 

Fig. 6.3. The Options Display Mode allows you to adjust the view mode for the Control Display Mode. 

The Options Display Mode holds a single option: 
• View: Sets the view for the Control Display Mode. For a detailed description of the 

available flavors, please refer to the section . 6.4.2. Control Display Mode above. 
• To switch between the view modes All, Potis and Single, use the Scrollwheel or the 

Left and Right Arrow Buttons on your Controller. 

O The current assignments for the 8 Controller Buttons and 8 Controller Knobs stay active 
when the Options Display Mode is activated. 

6.4.6 Templates Display Mode 
The Templates Display Mode is a bit particular. 
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• To activate the Templates Display Mode, press the Fl Button. 

The Templates Display Mode allows you to switch to another Template and to quit the 
MIDI Mode. 
This mode displays the list of Templates as defined in the Template List of the Inspector's 
Templates tab. The currently loaded Template is highlighted. 

O Please note that the current assignments for the 8 Controller Buttons and 8 Controller 
Knobs stay active when the Templates Display Mode is activated. 

This mode allows you two things: First, you can choose another Template for loading: 
• Use the Up/Down Arrow Buttons to select the previous/next Template. 
Or 

1. Use the Scrollwheel to navigate through the whole list. 
2. When the dotted frame surrounds the desired Template, press Enter to load it. 
Second, the Display Mode allows you to switch from MIDI Mode to KORE Mode: 
• To switch from MIDI Mode to KORE Mode, press the Control Button. 
If the KORE software is running (as standalone or as plug-in), you get to the last selected 
Display Mode inside KORE and you can use your KORE Controller with its dedicated soft-
ware. If the KORE software is not running, the Display shows a dimmed KORE message, 
waiting for you to start KORE. 

O At any time, you can press the Fl Button again or the Esc Button to get back to the previ-
ously selected Display Mode. 
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7 Using your TRAKTOR KONTROL X1 
In this chapter you will learn how to use your TRAKTOR KONTROL X1 in conjunction with 
the Controller Editor software. We will first list all assignable control elements on your con-
troller, then describe how the various luminous elements inform you about their state. 

To enjoy full functionality of your NI Controller as a MIDI remote control, especially con-
cerning some control elements' state and LED behaviour, you need to tell your NI Control-
ler what is the current state of the parameter in the MIDI target. You can do this by set-
ting up MIDI feedback channels coming from your MIDI target back to your NI Controller. 
This way, your controller will always stay up-to-date with the current parameter values in 
your target software/hardware. For more info on how to configure these MIDI feedback 
channels, please refer to your target software/hardware's documentation. 

7.1 Assignable Control Elements 
If you selected the TRAKTOR KONTROL X1 in the Application Control Bar's Device menu, 
here is how the Hardware area looks like: 
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The Hardware area representing the TRAKTOR KONTROL X 1 , with the Selection Frame 
(red) on the currently selected control element (here the Left Play Button). 
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All control elements of the TRAKTOR KONTROL X1 are freely assignable to any MIDI 
event (with the limitations due to the type of control element), with the exception of the 
Shift and Hotcue Buttons. These Buttons have specific functions explained in the next 
section. 

El The names that you see on many control elements only refer to their original function in 
the TRAKTOR software. 

The TRAKTOR KONTROL X1 interface holds the following assignable control elements: 
• 24 freely assignable Buttons. 
• 8 freely assignable Knobs. 
• 4 freely assignable Push Encoders. 

1.2 Special Control Elements 
Your TRAKTOR KONTROL X1 has two special control elements: the Shift Button and the 
Hotcue Button. These allow you to switch your controller to another state. 

7.2.1 Switching Between Knob Pages 
• To switch between the two available Knob Pages from your TRAKTOR KONTROL Xl, 

press the Shift Button. 
Furthermore, the behavior of the Shift Button depends on the setting in the Shift Mode 
menu, on the Pages tab of the Inspector. This Shift Mode menu allows you to select be-
tween two states: 
• Toggle: If this entry is selected, your controller switches to the other Knob Page and 

this Knob Page stays active even after you release the Shift Button. 
• Gate: If this entry is selected, your controller only switches to the other Knob Page as 

long as the Shift Button is hold depressed. When you release the Shift Button, the 
controller switches back to the previous Knob Page. This mode can be useful to brief-
ly activate other controls. 
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1.2.2 Switching Between MIDI Mode and TRAKTOR Mode 

• To switch your TRAKTOR KONTROL X1 between MIDI Mode and TRAKTOR Mode, 
press the Shift Button and the Hotcue Button simultaneously. 

O When TRAKTOR is running, the MIDI functionality of your TRAKTOR KONTROL X1 can 
be disabled with a Preferences option on the KX1 preferences page called Switch to MIDI 
via Shift+Hotcue (enabled by default). The purpose of this option is to avoid erroneous 
switching into MIDI mode during heavy usage of Shift and Hotcue Buttons. 

As a reminder: in MIDI Mode your TRAKTOR KONTROL X1 triggers MIDI events, whereas 
in TRAKTOR Mode it controls its dedicated software TRAKTOR. 

1.3 The Status LEDs 
All Buttons on your TRAKTOR KONTROL X1 are equipped with LEDs that inform you 
about their assignment status. The fast bidirectional communication between your control-
ler and the Hardware Controller Support on the software side allows updating in real time 
all status indications on your NI Controller. 
The LEDs below each control element can have three states: off, low brightness and high 
brightness. Their lighting behavior is as follows: 
• If the Button is not assigned, the LED is completely dark. 
• If the Button is assigned and in Toggle Mode, the LED has a low brightness to show 

the Off state and a high brightness to show the On state. 
• If the Button is assigned and in Trigger or Gate Mode, the LED behaviour is controlled 

by the MIDI target via a MIDI feedback channel: the MIDI target can send a MIDI 
message back to the controller that will define the LED's state. 

• If the Button is assigned and in Increment Mode, the LED stays at low brightness. 

0 
For more info on the various Button Modes, please refer to section r9.4.3, The Assign 
Tab in the reference chapter. 

You can define the LEDs' brightness of your TRAKTOR KONTROL X1 for both On and Off 
states in the Preferences window (see section ' 10.1.1, File Menu for more info). 
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8 Using your RIG KONTROL 3 
In this chapter, we will focus on what's happening on your RIG KONTROL 3. We will first 
list all assignable control elements on your controller, then describe how the various lumi-
nous elements inform you about their state. 

To enjoy full functionality of your NI Controller as a MIDI remote control, especially con-
cerning some control elements' state and LED behaviour, you need to tell your NI Control-
ler what is the current state of the parameter in the MIDI target. You can do this by set-
ting up MIDI feedback channels coming from your MIDI target back to your NI Controller. 
This way, your controller will always stay up-to-date with the current parameter values in 
your target software/hardware. For more info on how to configure these MIDI feedback 
channels, please refer to your target software/hardware's documentation. 

8.1 Assignable Control Elements 
If you selected the RIG KONTROL 3 in the Application Control Bar's Device menu, here is 
how the Hardware area looks like: 
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Fig. 8.1. The Hardware area representing the RIG KONTROL 3, with the Selection Frame (red) on the currently 
selected control element (here Foot Switch 8). 

The RIG KONTROL 3 interface holds the following areas: 
1. Foot Switches: In the left and main part, the Foot Switches are a set of eight buttons 

representing the eight Foot Switches of your RIG KONTROL 3. These eight control el-
ements are freely assignable. 

2. Pedal area: On the top, the Pedal area holds two freely assignable control elements 
corresponding to the two Pedal Inputs. 

3. Expression Pedal: In the right part, the Expression Pedal holds two freely assignable 
control elements: the Expression Pedal itself and the Expression Pedal Switch, locat-
ed under the pedal on your RIG KONTROL 3. 

8.2 Special Control Elements 
The RIG KONTROL 3 does not hold any function-specific controls: you are free to assign 
each and every control lying on its top panel. 
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8.3 The Status LEDs 
Most control elements on your RIG KONTROL 3 are equipped with LEDs that inform you 
about the assignment status of the control elements in real time. The fast bidirectional 
communication between your RIG KONTROL 3 and the Hardware Controller Support on 
the software side allows updating in real time all status indications on your NI Controller. 
The LEDs on each control element can have two states: on or off. Their lighting behavior 
depends on the type and status of the control element. 

8.3.1 Foot Switches 
Here are the rules for the eight Foot Switches on your RIG KONTROL 3: 
• If the Foot Switch is not assigned, the LED is completely dark. 
• If the Foot Switch is assigned and in Toggle Mode, the LED is off to show the Off 

state and lit to show the On state. 
• If the Foot Switch is assigned and in Trigger or Gate Mode, the LED behaviour is con-

trolled by the MIDI target via a MIDI feedback channel: the MIDI target can send a 
MIDI message back to the controller that will define the LED's state. 

• If the Foot Switch is assigned and in Increment Mode, the LED stays off. 

O For more info on the various Button Modes, please refer to section 110.4.3, The Assign 
Tab in the reference chapter. 

8.3.2 Expression Pedal 
Here are the rules for the Expression Pedal on your RIG KONTROL 3: 
• The assignment for the Expression Pedal itself is not shown by any LED: just look at 

the pedal and you will know its state! 
• The assignment for the Expression Pedal Switch is shown by the Pedal Switch LED 

(labelled Pedal, in the upper row on your RIG KONTROL 3): Its behaviour is the same 
as for the Foot Switches (see above). 
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O For more info on the various Button modes, please refer to section • 10.4 3. Tne Ass gn 
Tab in the reference chapter. 

8.3.3 Pedal Inputs 
Obviously, the Pedal inputs don't have any LEO! There is no way to see their assignment 
on your hardware: to do this, you have to check the Controller Editor window. 

8.4 The Display 
The LED Display of your RIG KONTROL 3 simply informs you about the current Mode of 
your Controller: 
• In GUITAR RIG Mode (i.e. if your Controller is connected to an instance of its dedi-

cated software), the LED Display shows you the number of the preset currently load-
ed. 

• In MIDI Mode (i.e. if your Controller is connected to the Controller Editor / NI Hard-
ware Service), the LED Display shows the letters con (for "Controller Editor"). 
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9 Using your AUDIO KONTROL 1 
In this chapter, we will focus on what's happening on your AUDIO KONTROL 1. We will 
first list all assignable control elements on your controller, then describe how the various 
luminous elements inform you about their state. 

m 
To enjoy full functionality of your NI Controller as a MIDI remote control, especially con-
cerning some control elements' state and LED behaviour, you need to tell your NI Control-
ler what is the current state of the parameter in the MIDI target. You can do this by set-
ting up MIDI feedback channels coming from your MIDI target back to your NI Controller. 
This way, your controller will always stay up-to-date with the current parameter values in 
your target software/hardware. For more info on how to configure these MIDI feedback 
channels, please refer to your target software/hardware's documentation. 

9.1 Assignable Control Elements 
If you selected the AUDIO KONTROL 1 in the Application Control Bar's Device menu, here 
is how the Hardware area looks like: 
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Fig. 9.1. The Hardware area representing the AUDIO KONTROL 1, with the Selection Frame (red) on the cur-
rently selected control element (here the Right Button). 

The AUDIO KONTROL 1 interface holds three buttons (Left, Middle and Right Button) 
along with a jog wheel (Controller Knob): 
• The Middle Button, Right Button and Controller Knob are freely assignable. 
• The Left Button has a special behaviour (see below). 

9.2 Special Control Elements 
Your AUDIO KONTROL 1 has one special control element: the Left Button. This Left But-
ton allows you to switch between both Knob Pages. 
• To switch between the two available Knob Pages from your AUDIO KONTROL 1, press 

the Left Button. 
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Furthermore, the behavior of the Left Button depends on the setting in the Shift Mode 
menu, on the Pages tab of the Inspector. This Shift Mode menu allows you to select be-
tween two states: 
• Toggle: If this entry is selected, your controller switches to the other Knob Page and 

this Knob Page stays active even after you release the Left Button. 
• Gate: If this entry is selected, your controller only switches to the other Knob Page as 

long as the Left Button is hold depressed. When you release the Left Button, the con-
troller switches back to the previous Knob Page. This mode can be useful to briefly 
activate other controls. 

9.3 The Status LEDs 
All control elements on your AUDIO KONTROL 1 are equipped with LEDs that inform you 
about the assignment status of the control elements in real time. The fast bidirectional 
communication between your AUDIO KONTROL 1 and the Hardware Controller Support on 
the software side allows updating in real time all status indications on your NI Controller. 
The LEDs on each control element can have two states: on or off. Their lighting behavior 
depends on the type and status of the control element. 

9.3.1 Left Button 
The LED on the Left Button indicates which Knob Page is activated: 
• If the first Knob Page is activated, the Left Button's LED is dark. 
• If the second Knob Page is activated, the Left Button's LED is lit. 

9.3.2 Controller Knob 

Here are the rules for the Controller Knob on your AUDIO KONTROL 1: 
• If the Controller Knob is not assigned, the LED ring around it is dark. 
• If the Controller Knob is assigned, the LED ring is lit. 

9.3.3 Middle and Right Buttons 
Here are the rules for the Middle and Right Buttons on your AUDIO KONTROL 1: 
• If the Button is not assigned, the LED is completely dark. 
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• If the Button is assigned and in Toggle Mode, the LED is off to show the Off state and 
lit to show the On state. 

• If the Button is assigned and in Trigger or Gate Mode, the LED behaviour is controlled 
by the MIDI target via a MIDI feedback channel: the MIDI target can send a MIDI 
message back to the controller that will define the LED's state. 

• If the Button is assigned and in Increment Mode, the LED stays off. 

O For more info on the various Button Modes, please refer to section ' 10.4.3, The Assign 
Tab in the reference chapter. 
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10 Reference 
This chapter systematically describes all the user interface elements of the Controller Edi-
tor. The Controller Editor is the "control tower" of your NI Controller's remote control sys-
tem. It stores the links between hardware actions (what you do on your NI Controller) and 
MIDI events (what you want to be done within a specific piece of MIDI-capable software or 
hardware). 

10.1 The Application Menu Bar 
The Controller Editor menu bar contains three menus: the File menu, the View menu and 
the Help menu. 

Elle Del,  tidy 

Fig. 10.1. The Application Menu Bar, with its three menus. 

10.1.1 File Menu 
The File menu allows you to manage the Configuration files, to tweak the overall behavior 
of the application, and to quit the Controller Editor. The menu contains the following en-
tries: 
• Open Configuration: Opens a dialog allowing you to select the Configuration file you 

want to load. The Configuration file contains all data sets used by the Controller Edi-
tor. For one NI Controller, the data set contains the list of all Templates, all data in 
the Templates in the list, and the index of the currently selected Template—to sum 
up, the Configuration file contains everything you can store for use with the Controller 
Editor. To load a Configuration file, select Open Configuration from the File menu, 
navigate to the desired Configuration file in the dialog that appears, and double-click 
it (or click it, then click on the "Open" button). It will replace the currently loaded 
configuration. 
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• Save Configuration As...: Opens a dialog allowing you to save the current Configuration 
file under another name. In the dialog, type the desired name for the new Configura-
tion file, then click on the "Save" button. 

O You can also use the Save Configuration As... command as a backup function: Save your 
Configuration file somewhere else (hard drive, USB key...), and you will be able to load it 
again. 

m 
There is no Save entry in the File menu. The Controller Editor will remember the current 
configuration the next time you open the software. Be aware that loading another Configu-
ration file will overwrite the current configuration! 

• Open Template...: Opens a dialog allowing you to select a Template file for loading for 
the currently selected NI Controller. The Template will be appended to the Template 
List in the Inspector. This command mirrors the command Append located in the 
Template Edit menu (see ' 9.4.1, The Templates Tab for more info on the Template 
List and the Template Edit menu). 

• Preferences...: Opens the Preferences window. This window allows you to tune some 
global parameters of the Controller Editor. See below for an explanation of the availa-
ble parameters. 

• Exit: Quits the Controller Editor application. Note that all assignments stay active 
thanks to the NI Hardware Service running in background. 

The Preferences Window 

The Preferences window shows two tabs: the General tab and the Controller tab. To show 
each tab, click on its label. 
The General tab offers two options: 
• Touch Select: If this option is activated, you can select the desired control element di-

rectly from within your NI Controller, the selection of any control element becoming 
more intuitive. This can be useful to quickly assign the control elements: you don't 
need to move your mouse back and forth repeatedly between the Hardware area 
(where you select some control element) and the Inspector's Assign tab (where you 
can see or modify the corresponding assignment)—instead, as soon as you touch the 
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desired control element on your NI Controller, it is automatically selected in the Con-
troller Editor (the red Selection Frame focuses on it) and its assignment is automati-
cally shown in the Assign tab of the Inspector. You can now focus on this Assign tab 
on your computer screen, making all selections from your hardware. This can be for 
example a very efficient way to work on large series of assignments. Moreover, this en-
sures you that you're really dealing with the control element you plan to use for that 
particular task. This feature can be also used together with the Minimize/Expand View 
button (see section ' 9 2 4. Minimize/Expand View Button). 

• Wrap Template and Page Lists: If activated, the selection jumps to the other end of the 
Template and Knob Page List whenever you press the Previous or Next Button while 
the first or last list entry is selected—in other terms, you "loop" the lists by joining 
both ends. 

The Controller tab allows you to adjust the settings for your NI Controllers: 
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Fig. 10.2. The Controller tab of the Preferences window, here showing the settings for the KORE 2 Controller. 

1. Click on the Controller menu at the top. This menu lists all NI Controllers installed on 
your computer. 

2. In the drop-down list, select the NI Controller for which you want to adjust the param-
eters. 

Upon your selection, the rest of the Controller tab displays the available settings for that 
particular NI Controller. 
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Settings for the MASCHINE Controller and KORE Controllers 

For the MASCHINE and KORE Controllers, the settings are exactly the same as those avail-
able on your Controller's Display(s) in Settings Display Mode (MASCHINE Controller) and 
Setup Display Mode (KORE Controller). For all details about these controller-specific set-
tings, please refer to the corresponding sections 5.4.7, Settings Display Mode for the 
MASCHINE Controller, and 6.4.4, Setup Display Mode for the KORE Controller. 
For the KORE Controllers, you see an additional Enable Controller check box. See below 
for more info on this. 

Settings for the TRAKTOR KONTROL )(1 

For the TRAKTOR KONTROL Xl, the Controller tab offers three settings: 
• Effect Knobs Recalibrate: This allows you to recalibrate the eight Effect Knobs (the 

Knobs arranged on two columns at the top of your TRAKTOR KONTROL X1), in order 
to correct potential inaccuracies of both center position and range of the Knobs. To 
start the calibration process, click on the Recalibrate button. The process consists of 
three steps, which ask you to turn the Knobs fully to the left, fully to the right and to 
the center position. 

M Doing the calibration is not mandatory since the device is pre-calibrated in the factory. It 
is anyhow possible that some Knobs do not read the value 64 in the center position, what 
requires to run through the calibration process for all Knobs on the TRAKTOR KONTROL 
x1. 

• LEDs On-State Brightness: Sets the brightness for the On state of the Buttons on your 
Controller. 

• LEDs Off-State Brightness: Sets the brightness for the Off state of the Buttons on your 
Controller. 

• Start in MIDI-Mode: If this check box is activated, your TRAKTOR KONTROL X1 will be 
in MIDI Mode as soon as you start your computer, thus avoiding you to switch it to 
MIDI Mode manually. 

Settings for the RIG KONTROL 3 

For the RIG KONTROL 3, the Controller tab offers three settings: 
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• Recalibrate: This button allows you to recalibrate the Expression Pedal along with the 
two possible external pedals connected to the Pedal Inputs on your Controller. To re-
start the calibration process, click on the button. A warning dialog asks you to press 
all pedals all the way up, then down, then at the middle position. The calibration is 
then done. 

• Start in MIDI-Mode: If this check box is activated, your RIG KONTROL will be in MIDI 
Mode as soon as you start your computer, thus avoiding you to switch it to MIDI Mode 
manually. 

• Enable Controller: See description below. 

Settings for the AUDIO KONTROL 1 
For the AUDIO KONTROL 1, the Controller tab offers two settings: 
• Direct Monitoring: The Audio Channels menu allows you to select the output pair from 

the four Main Output Jacks to which the Direct Monitoring signal has to be sent. You 
can choose from pair 1/2, 3/4 or Al!. 

• Enable Controller: See description below. 

Enabling and Disabling a Controller (KORE Controller, RIG KONTROL 3 and AUDIO KONTROL 1 only) 

Fig. 10.3. The Enable Controller checkbox, at the bottom of the Controller tab. 

The Enable Controller checkbox allows you to enable and disable your KORE Controller, 
your RIG KONTROL or your AUDIO KONTROL 1. If you want to use your KORE Controller 
in conjunction with versions of the KORE software previous to 2.1, your RIG KONTROL in 
conjunction with versions of the GUITAR RIG software previous to 4 or your AUDIO KON-
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TROL 1 with the legacy Mapping Application, it is necessary to disable your NI Controller 
here. It is always activated by default. This is what will happen when you disable the Con-
troller: 
• The NI Controller's entry disappears from the View menu's Select Device submenu 

(see below) and from the Application Control Bar's Device menu (see section 9.2.1. 
Device Menu). 

• If the corresponding NI Controller is currently connected to your computer, it is shut 
down. All LEDs and Display(s) are turned off on your NI Controller and you cannot use 
it anymore as a MIDI remote control. 

After enabling/disabling any of the NI Controllers, you need to restart your computer in or-
der to apply the changes! 

10.1.2 View Menu 
The View menu controls the layout of the Controller Editor interface. This menu contains 
two entries: 
• Select Device: This submenu lists all NI Controllers currently activated as MIDI remote 

controls, as defined by the various Enable Controller options explained right above. By 
selecting an entry in this submenu, you choose the NI Controller on which you want to 
see/modify the MIDI assignments. The Hardware area along with all Templates / Knob 
Pages / Pad Pages / Assignments are updated accordingly. This submenu is also mir-
rored by the Device menu, located at the left of the Application Control Bar (see sec-
tion ' 92',  Device Menu). 

• Hide/Show Hardware Device: Hides/shows the Hardware area in the Controller Editor 
interface. This command is equivalent to the Minimize/Expand View button in the Ap-
plication Control Bar. Showing the Hardware area is useful if you prefer to use the 
mouse to select each control element, in order to see or modify its assignments. The 
downside is that showing the complete user interface requires quite a lot of space on 
your computer screen. You can reduce the amount of space Controller Editor requires: 
select this command to hide the Hardware area and most of the Application Control 
Bar. With these parts of the user interface hidden, you can still manage your Tem-
plates, Knob Pages and Pad Pages via the Templates and Pages tabs of the Inspector. 
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You can even continue working on each assignment by selecting the corresponding 
control element directly on your NI Controller, provided that you activated the Touch 
Select option in the Preferences Window (General tab, see above). Moreover, you can 
switch to another NI Controller via the Select Device entry in this same View menu. 

10.1.3 Help Menu 

The Help menu gives you access to information that might help you in the use of the Con-
troller Editor. The menu contains five entries: 
• Open Manual...: Opens the PDF version of this manual, located in the Controller Editor 

installation folder. 
• Open Template Documentation...: Opens the PDF documentation which explains you 

how to use predefined Templates for use with specific Native Instruments and Third 
Party products. 

• Launch Service Center...: Launches the NI Service Center. The NI Service Center helps 
you to activate your Native Instruments product (if activation is required) and after-
wards lets you access product updates. Find more information about the NI Service 
Center in the separate Quick Start Guide, located in the Service Center installation 
folder. 

• Visit the Knowledge Base...: Opens the Knowledge Base on the Native Instruments 
website in your web browser. This web page provides you with useful information 
about NI products, among them the Controller Editor. 

• Visit Native Instruments on the web...: Opens the Native Instruments home page in your 
web browser. 

• About...: Opens the About dialog (like clicking the Native Instruments logo). This dia-
log contains valuable information about the software such as its version number. 

10.2 The Application Control Bar 
The Application Control Bar provides you with some global features controlling the behav-
ior of the Controller Editor. 
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10.4. The Application Control Bar contains some important features of the Controller Editor. 

10.2.1 Device Menu 

Fig. 10.5. The Device menu. 

The Device menu informs you which NI Controller's assignments you are working on. Fur-
thermore, it allows you to switch to another NI Controller in order to see and edit its as-
signments. This menu mirrors the Select Device submenu located in the Application Menu 
Bar's View menu. 
To switch to another NI Controller, do the following: 
1. Click on the Device menu to open a drop-down list containing all NI Controllers acti-

vated for MIDI, as defined by the Enable Controller options in the Preferences win-
dow. 

2. In the list, select the desired NI Controller. 
The Hardware area is updated accordingly and all Templates / Knob Pages / Pad Pages / 
Assignments are recalled for the newly selected NI Controller. 
All parameters and settings displayed in the Controller Editor's interface refer to the NI 
Controller currently selected in this Device menu, with the exception of the MIDI Activity 
Indicator and the NI Logo, at the far right of the Application Control Bar. 
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a Worth to note is that all NI Controllers currently in MIDI Mode are still active, no matter 
which Controller is displayed in the Controller Editor. 

10.2.2 Connect Button 

Fig. 10.6. The Connect button. 

The Connect button allows you to "call" your NI Controller, in case it is currently control-
ling its dedicated software (i.e. KORE, GUITAR RIG, TRAKTOR or MASCHINE). This is the 
software equivalent to pressing the Shift + Control (MIDI) buttons on your MASCHINE 
Controller, to the Shift + Hotcue buttons on your TRAKTOR KONTROL X1 and to the Fl -
Control command on your KORE 2 Controller (or View — Control on your KORE 1 Control-
ler). 
Indeed, your NI Controller can only connect to one application at a time: 
• The NI Controller can either be connected to its corresponding software, e.g. KORE 2 

(or one of its various plug-in instances currently running on your computer), 
or 
• It can connect to the Hardware Controller Support service, which is the gate to remote 

controlling all other MIDI targets from your NI Controller—and whose assignments are 
defined via the Controller Editor. 

When you start the Controller Editor, it automatically connects to your NI Controller(s)—
the rule is: the last started application takes control over your NI Controller. For example, 
if you launch the MASCHINE software (as a stand-alone application or a plug-in instance) 
while the MASCHINE Controller is in MIDI Mode, you need to switch the MASCHINE Con-
troller to this MIDI Mode again in order to continue using it as a MIDI remote control. You 
can do this either from your NI Controller or from within the Controller Editor, via this Con-
nect button. 
From your NI Controller: 
• On your MASCHINE Controller, press Shift + Control (MIDI) at the same time. This 

switches your MASCHINE Controller to MIDI Mode. 
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• On your KORE 2 Controller, press Fl, then Control. This switches your KORE 2 Con-
troller to MIDI Mode. 

• On your KORE 1 Controller, press View, then Control. This switches your KORE 1 
Controller to MIDI Mode. 

• On your TRAKTOR KONTROL Xl, press Shift + Hotcue (MIDI) at the same time. This 
switches your TRAKTOR KONTROL X1 to MIDI Mode. 

In the Controller Editor, if the Connect button is off (the button is not lit), your NI Control-
ler is connected to an instance of its dedicated software (e.g. KORE 2 for the KORE 1 or 2 
Controllers). 
• To activate the MIDI Mode and connect your NI Controller to the Controller Editor, 

click on the Connect button (which will change to its "on" state). 

© You don't need to have the Controller Editor open to switch to MIDI Mode from your MA-
SCHINE Controller, KORE Controller or TRAKTOR KONTROL Xl! 

M On the RIG KONTROL 3, there is no possibility to switch the Controller's mode. 

If your NI Controller is switched to MIDI Mode, the Connect button in the Controller Editor 
is lit. If not, the button is off. In short, the Connect button displays which mode your NI 
Controller is currently in. 
If your NI Controller is not physically connected to your computer at the moment, the Con-
nect button is grayed out and inactive: 

Fig. 10.7. Grayed out Connect button. 

10.2.3 Template Select Menu 

Fig. 10.8. The Template Select menu allows you to select the desired Template. 
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The Template Select menu allows you to choose a Template from the list of all available 
Templates for the NI Controller currently selected in the Device menu. 

O Please read chapter t 4.3.4, Templates for more info on Templates and what they are for. 

• To load a particular Template, click on the Template Select menu and select the de-
sired entry from the list. 

The corresponding Template will automatically be loaded. This will replace the current 
Template, along with all its Knob Pages (MASCHINE Controller, KORE Controllers and 
TRAKTOR KONTROL X1), Pad Pages (MASCHINE Controller) and assignments. 
The menu contains Factory Templates as well as User Templates that you might have cre-
ated. 

O For more info on how to create and manage Templates, please refer to section 10 4.1. 
The Templates Tab in this reference chapter. 

10.2.4 Minimize/Expand View Button 

Fig. 10.9. The Minimize/Expand View button. 

The Minimize/Expand View button shows a little arrow pointing either to the right or to the 
left. This button allows you to show or hide the Hardware area (and a part of the Applica-
tion Control Bar), in order to save space on your screen. By reducing the size of the Con-
troller Editor window on your screen, you get a better overview of other applications. 
This button is equivalent to the Hide/Show Hardware Device command in the Application 
Menu Bar's View menu. 
• If the Hardware area is shown, click on the Minimize/Expand View button to hide it. 
The Controller Editor interface shrinks to one single column: The Hardware area disap-
pears, the Application Menu Bar and the Inspector remain untouched, whereas the Appli-
cation Control Bar only shows this same Minimize/Expand View button, the Template Se-
lect menu, a minimized version of the MIDI Activity Indicator and the NI Logo: 
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Fig. 10.10. The Controller Editor in minimized view. 
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• To show the Hardware area again, click again on the Minimize/Expand View button 
(now showing a little arrow to the left). 

This feature is very useful in any situation where you do not need the Hardware area, for 
example: 
• If you only want to manage your Templates and Knob Pages/Pad Pages, you only need 

the Templates and Pages tabs of the Inspector. 
• If you activated the Touch Select option in the Preferences window (see section 

110.1.1, File Ivlenu), you can select all control elements directly from your NI Control-
ler; thus, you don't need the Hardware area anymore and you can continue working on 
your assignments in the Inspector. 

O You can still switch to another NI Controller when the Controller Editor is minimized by 
calling the Select Device command in the View menu of the Application Menu Bar! 

10.2.5 MIDI Activity Indicator 

Fig. 10.11. The MIDI Activity Indicator. 

The MIDI Activity Indicator displays incoming (In) and/or outgoing (Out) MIDI data. This 
can be useful to check if everything is fine between the Controller Editor and its hardware 
and software environment in your setup, and more generally, for any MIDI debugging pur-
pose. 

10.2.6 NI Logo 

Fig. 10.12. The NI Logo. 
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When you click on the NI Logo, located on the far right of the Application Control Bar, the 
About dialog opens. 
This About dialog provides you with some interesting information about your Controller Ed-
itor installation, including the version number and the credits. 

O The About dialog can also be opened by selecting the About... entry in the Help menu, in 
the Application Menu Bar. 

10.3 The Hardware Area 
When shown (see section ' 9.2.4, Minimize/Expand View Button above), the Hardware 
area basically represents the NI Controller that you are currently using. The Hardware area 
has two main purposes: 
• It provides you with a graphical representation of your NI Controller, for ease of use. 
• It allows you to select the Template, Knob Page (except for the RIG KONTROL 3), 

Pad Page (MASCHINE Controller) and control element that you wish to load or edit. 
For example, this can be particularly useful if your NI Controller is not currently con-
nected to your computer. That way, you can prepare your assignments even if the 
hardware is not currently there. 

In addition to the exact representation of your NI Controller, the Hardware area holds a few 
extra graphical elements that extend its usability: the Label Fields, the Selection Frame, 
the Knob Page area/Knob Page menu (except for the RIG KONTROL 3) and the Pad Page 
area/Pad Page menu (MASCHINE Controller only). Let's describe each of these. 

10.3.1 Label Fields 
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For every control element of the Hardware area that can be assigned to some MIDI mes-
sage, you find a Label Field above or below it. This field mirrors the Label Field located in 
the upper part of the Assign tab, in the Inspector, so that you can see all control elements 
along with their names. 
If no name has been defined yet for a control element, its Label Field displays by default 
the MIDI message assigned to that control element. 
Like all other assignments properties, these names are of course saved within the Knob 
Pages / Pad Pages / Templates. 

M Many of the control elements already have a name on them in the Hardware area: this 
name only refers to their original function in their dedicated software (MASCHINE, KORE, 
TRAKTOR or GUITAR RIG). 

10.3.2 Selection Frame 

Fig. 1O.13. The Selection Frame highlights the control element that is currently focused. 

The Selection Frame is a red frame highlighting the currently selected control element. 
Whenever you select another control element in the Hardware area (or, with the Touch Se-
lect option activated in the Preferences, on your NI Controller), the Selection Frame will 
highlight this control element. At the same time, the Assign tab in the Inspector shows the 
assignment properties for that element. 
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10.3.3 Knob Page Area and Knob Page Menu (MASCHINE and KORE Controllers, TRAKTOR 
KONTROL XI, AUDIO KONTROL 1 only) 

Knob Page Area 

The Knob Page area holds all control elements included in a Knob Page (here on the MA-
SCHINE Controller). 
Inside the Hardware area, an orange frame highlights some of the control elements. This 
frame defines the Knob Page area, which holds all control elements included in the Knob 
Pages system. 

O As a short reminder: The control elements located in the Knob Page area can have multi-
ple assignments, which are stored on so-called Knob Pages—with, on each Knob Page, 
one assignment for one control element (for a general explanation of the Controller Edi-
tor's mapping system, see section . 4.3. The tvlappmg System). 
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Knob Page Menu 

Fig. 10.14. The Knob Page menu allows you to select another Knob Page (here on the KORE 2 Controller). 

At the Knob Page area's upper left corner, the Knob Page menu shows you the name of 
the currently selected Knob Page. Moreover, it allows you to select another set of assign-
ments: 
• To select a particular Knob Page, click on the Knob Page menu and choose the de-

sired entry from the list—this list mirrors the Knob Page List in the Inspector's Pages 
tab. 

The selected Knob Page loads automatically, replacing the Knob Page currently loaded. 

10.3.4 The Page Buttons (MASCHINE and KORE Controllers) 

Fig. 10.15. The Page Buttons allow scanning the entire Knob Page List (and Template List on the MASCHINE 
Controller). 
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The Page Buttons are another way to navigate through your different Knob Pages and Tem-
plates. These two buttons, showing orange arrows, are located in the top left part on the 
MASCHINE Controller, and right below the Display on the KORE Controllers. 
• To load the previous/next Knob Page, click on the Page Buttons. 
The current Knob Page is replaced with the previous/next one in the Knob Page List. 
On the MASCHINE Controller, these buttons also allow you to navigate through your Tem-
plates: 
• To load the previous/next Template, press the Shift button on your MASCHINE Con-

troller (or on your computer keyboard) and hold it pressed while using the Page But-
tons. 

The current Template is replaced with the previous/next one in the Template List. 

O To manage your Knob Pages and Templates within the Knob Page List and Template List, 
use the Inspector. For more info on this, please refer to section - 10.4, The Inspector lat-
er in this manual. 

These buttons have their exact equivalent on your NI Controller: you can use them to jump 
to the previous/next Knob Page (or Template on the MASCHINE Controller). 
Note that when you reach an end in one of the lists, let's say the last Knob Page in the 
Knob Page List, you have two possibilities: 
• If you activated the Wrap Template and Page Lists option in the Preferences window 

(General tab), if you press again on the Next Button, you jump back to the beginning 
of the list. 

• If the Wrap Template and Page Lists option is deactivated, you stay on this last Knob 
Page. even if you press further on the Next Button. 

10.3.5 The Pad Pages (MASCHINE Controller only) 
The MASCHINE Controller holds an additional paging system which is very similar to the 
previous one: the Pad Pages. The Pad Pages allow you to store multiple assignments for 
the sixteen Pads of the MASCHINE Controller. Whereas the number of Knob Pages is un-
limited, you can only use eight Pad Pages (which still make 8 x 16 = 128 possible assign-
ments for the Pads!). 
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This Pad Page feature is optional: you can activate/deactivate it at any time by switching 
the Pad Pages button on or off in the Inspector's Pages tab (see section r 10.4.2. The Pa-
ges Tab (MASCHINE Controller, KORE Controllers, TRAKTOR KONTROL X1 and AU-
DIO KONTROL 1 only)). 
If the Pad Page feature is activated, you get access to eight sets of assignments for your 
Pads. If the feature is deactivated, you only have one set of Pads waiting for being as-
signed. 

Pad Page Area and Pad Page Menu 

Fig. 10.16. The Pad Page area, with its associated Pad Page menu at the top left corner. 

The square of Pads, called Pad Page area, is outlined by a blue frame. 
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Like for the Knob Pages, a Pad Page menu at the frame's upper left corner shows you 
which page of assignments is currently loaded for the Pads, and allows you to select an-
other Pad Page: 
• To select another Pad Page, click on the Pad Page menu and select another entry in 

the list that appears—like for the Knob Pages, this list mirrors the Pad Page List in 
the Inspector's Pages tab. 

Groups Buttons 

Fig. 10.17. The Groups area holds eight Group Buttons, labelled from A to H, each of them selecting one Pad 
Page. 

Like for the Knob Pages with the Page Buttons, there is an alternative way of selecting any 
particular Pad Page: the Group Buttons. These buttons are labeled from A to H, and they 
are located in the Groups area, in the middle left part of the Hardware area/MASCHINE 
Controller (the name "Group" is used here because it is the name appearing on your MA-
SCHINE Controller!). 
• Click on the desired Group Button to select the corresponding Pad Page. 

O You can also press the corresponding button on your MASCHINE Controller. This will ac-
tually be the preferred way in any live situation! 
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O 
If the Pad Pages button is deactivated in the Pages Tab of the Inspector, these eight 
Group Buttons behave like any other control button of the hardware: they are freely as-
signable. For more info, please refer to chapter ' 10.4.2. The Pages Tab (MASCHINE 
Controller, KORE Controllers, TRAKTOR KONTROL X1 and AUDIO KONTROL 1 only) 
in this manual. 

10.4 The Inspector 
Located on the right of the Controller Editor's window, the Inspector is THE definitive 
place to edit and organize your Templates, Knob Pages, Pad Pages and all your control as-
signments. For that reason, the Inspector is always visible. 

© If you are not sure about the terms "Template", "Knob Page", "Pad Page", etc.. read sec-
tion ' 4 3. The Maimmg System again, where these basic concepts are explained. 

As we already mentioned, the basic mapping workflow practically dives into the assign-
ment hierarchy. Let's quickly look at it again: 
1. From the Application Control Bar's Device menu, select the NI Controller which you 

want to work with. If you have only one Controller installed, it is automatically select-
ed. 

2. Choose a Template. This can be done for example via the Template Select menu in 
the Application Control Bar or via the Templates tab of the Inspector (see below). As 
the Template loads, all its included (possible) Knob Pages, (possible) Pad Pages and 
assignments are loaded. 

3. If the control element that you want to edit is located within the Knob Pages area, 
you also have to select the desired Knob Page; if your control element is a Pad on the 
MASCHINE Controller and if the Pad Pages feature is activated, you have to select 
the desired Pad Page. This can be done either via the Knob Page (or Pad Page) menu, 
or via the Previous/Next (or Group) Buttons, or via the Pages tab of the Inspector (see 
below). If the control element is somewhere else on the NI Controller, skip this step. 

If you only want to use the assignments as they are, that's all. But if you want to check the 
assignments or modify them, follow the next steps: 
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1. Put the focus on the control element that you want to edit. This can be done either in 
the Hardware area or directly on your Controller (if the Touch Select button is activat-
ed in the General tab of the Preferences window) by clicking/touching the desired 
control element. 

2. Navigate to the Assign tab of the Inspector (see below) and tweak the assignment 
properties for this control element. 

Tabs in the Inspector 
The Inspector is divided into three tabs, each of them taking care of a specific level in the 
Controller Editor's mapping system: 
• The Templates tab allows you to manage your Templates. 
• The Pages tab allows you to organize your Knob Pages. This tab is not available for 

the RIG KONTROL 3. When working with the MASCHINE Controller, this Pages tab 
also allows you to activate and organize the Pad Pages. 

• Last but not least, the Assign tab allows you to edit very precisely the MIDI assign-
ment for the control element currently selected in the Hardware area. 

Let's describe each of these three tabs thoroughly. We will follow the usual workflow, start-
ing with the Templates, then look at the Knob Pages (and Pad Pages), and finally describ-
ing all details of the assignments. 

10.4.1 The Templates Tab 

The Templates tab allows you to select and manage your Templates. The Templates can 
be used to store a whole set of assignments, Knob Pages and Pad Pages, for example for a 
specific use: a particular hardware instrument, a particular software configuration for a live 
set, a particular song of your set, etc. 
• To show the Templates tab, click on the label Templates. 

Template List 
At the top of the Templates tab, the Template List displays all available Templates: 
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Fig. 10.18. The Template List, at the top of the Templates tab. 

In this list, each entry represents a Template. The currently selected Template is high-
lighted in the list. 
• To select another Template, simply click on its entry. 
The selected Template is automatically loaded, with all its Knob Pages, Pad Pages and 
control assignments. 

O You can also select another Template via the Template Select menu located in the Appli-
cation Control Bar (see section . 10 2 3. Template Select Menu). 

Each entry in the Template List has two elements: the Template number and the Template 
name. The Template number is not editable—it defines the order of appearance of the 
Template in the list. The Template name is editable: 
• To rename the Template, double-click on its name (it is then highlighted), type a new 

name, and press [Enter] on your computer keyboard. 
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For your convenience, you can reorder the Templates in the list by drag and drop. This can 
be useful if you plan to use several Templates for a live performance and you need to have 
them available in a specific order from your NI Controller: When they are well ordered, you 
can easily switch to the previous/next one using the following methods: 
• MASCHINE Controller: use the Page Buttons in conjunction with the SHIFT Button or 

switch to the Template Display Mode (see section ' 5 4.5. Template Display Mode). 
• KORE Controller: switch to the Templates Display Mode (see section 7 6.4.6, Tem-

plates Display Mode). 

M There is no way to switch between Templates from the RIG KONTROL 3 nor from the 
TRAKTOR KONTROL Xl. 

If the number of Templates is too big to fit in the displayed Template List, a scrollbar ap-
pears on the right to navigate through the list. 

Edit Menu 
Located below the Template List, the Edit menu gives you access to important manage-
ment functions. To access any of these functions, click on the Edit menu and select the 
desired entry: 

Fig. 10.19. The Edit menu, below the Template List. 

The following commands are available: 
• New: Creates a new default Template. This new Template is appended at the end of 

the list. You can have as many Templates as you want in your list. 
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• Append: Opens a dialog allowing you to navigate to the desired Template file on your 
hard drive to load it. Select the Template file and click on OK (or double-click the 
Template file): the Template will be appended at the end of the list and will automati-
cally be loaded as current Template. 

• Replace: Opens a dialog allowing you to navigate to the desired Template file on your 
hard drive to load it. Select the Template file and click on OK (or double-click the 
Template file): the Template will be loaded and replace the currently selected Tem-
plate in the Template List. 

• Save As...: Opens a dialog allowing you to store the selected Template as a file on 
your hard drive (file extension ".ncm" for MASCHINE Controller, ".nck" for KORE 
Controllers, ".nckx1" for TRAKTOR KONTROL Xl, ".ncg" for RIG KONTROL 3 or 
".nckl" for AUDIO KONTROL 1 Template files). 

• Duplicate: Duplicates the selected Template and insert it into the list at the position 
below. 

• Delete: Removes the selected Template. The entries below are moved up to fill the 
gap. 

Template Properties (MASCHINE and KORE Controllers, RIG KONTROL 3 and AUDIO KONTROL 1 only) 

M There is no Template Properties area for the TRAKTOR KONTROL X1. 

The Template Properties area contains settings for the Template selected in the Template 
List: 

Fig. 1O.20. The Template Properties on the Templates tab (here for the MASCHINE Controller). 

Here, you find one or two menus, depending on the selected Controller: 
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• Pad Velocity Curve menu (MASCHINE Controller only): Allows you to choose from a list 
of seven velocity curves that affect the behavior of the Pads on your MASCHINE Con-
troller. A velocity curve defines how the pressure on the Pads has to be translated into 
velocity values. In the Pad Velocity Curve menu, you can choose between three soft, 
three hard and one linear curve. The soft curves are boosting lower pressure values 
and damping higher pressure values (logarithmic response), the hard curves are 
damping lower pressure values and boosting higher pressure values (exponential re-
sponse). The linear curve will translate pressure values into velocity values proportion-
ally. 

• MIDI Port menu: This menu allows you to specify whether you want to send the MIDI 
messages to the internal (virtual) MIDI port or to the external (physical) MIDI port of 
your NI Controller. When you click on this menu, you see two options: 
- Internal: The MIDI messages are routed through the internal MIDI port. This way, 

they can target other MIDI-capable applications running on your computer (provid-
ed that these applications are listening to this MIDI port—this has to be set in the 
target application's preferences). 

- External: The MIDI messages are routed through the MIDI output of your NI Con-
troller. That way, your Template can target other MIDI-capable hardware devices 
directly. 

10.4.2 The Pages Tab (MASCHINE Controller, KORE Controllers, TRAKTOR KONTROL X1 and 
AUDIO KONTROL 1 only) 

The Pages tab allows you to select and manage your Knob and Pad Pages. 

M Remember that, according to the Controller Editor's mapping system, all operations made 
in the Pages tab affect the Knob Pages or Pad Pages (for the MASCHINE Controller) lo-
cated in the Template that is currently loaded! 

The Knob Pages are sets of assignments for the control elements located in the Knob Page 
area of the Hardware area. For example, the Knob Pages can be used to store the assign-
ments for a particular patch of your target instrument, or for a specific section (filter sec-
tion, effect section, etc.) of your instrument, or for different instruments in your setup. 
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Knob Page List 
The Pages tab has some similarities with the Templates tab explained above. Similar to 
the Templates tab, the upper part of the Pages tab holds a Knob Page List. This list dis-
plays all Knob Pages available in the current Template: 

Fig. 10.21. The Knob Page List, at the top of the Pages tab. 

In this list, each entry represents a Knob Page. The currently selected Knob Page is high-
lighted. 
• To select another Knob Page, simply click on its entry. 
The selected Knob Page is automatically loaded, with all its control assignments. 

O You can also select another Knob Page via the Knob Page menu on the top of the Knob 
Page area or possibly via the Page Buttons, both in the Hardware area or on your NI Con-
troller. See sections ' 10 3 3. Knob Page Area and Knob Page Menu (MASCHINE and 
KORE Controllers, TRAKTOR KONTROL X1. AUDIO KONTROL 1 only) and ' 10.3.4. 
The Page Buttons (MASCHINE and KORE Controllers) for more info on this. 

Each entry in the Knob Page List consists of a number and a name. The Knob Page num-
ber is not editable—it defines the order of appearance of the Knob Page in the list. The 
Knob Page name is editable: 
• To rename the Knob Page, double-click on its name (it is then highlighted), type a 

new name, and press [Enter] on your computer keyboard. 
Like in the Template List, you can reorder the Knob Pages in the list by drag and drop: 
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• To move a Knob Page in the list, click on its entry, move your mouse vertically while 
holding the mouse button depressed, and release the mouse button at the desired lo-
cation. 

The Knob Page takes its new place in the list. 
This can be useful in a live situation, for example if you plan to use several Knob Pages for 
different parts of a song, and you need to have them in a specific order: When they are 
well ordered, you can easily switch to the previous/next one by using the Page Buttons on 
your NI Controller. 

M You cannot reorder the Knob Pages for the TRAKTOR KONTROL X1 nor for the AUDIO 
KONTROL 1. 

If the number of Knob Pages is too big to fit in the displayed Knob Page List, a scrollbar 
appears on the right to navigate through the list. 

Edit Menu (MASCHINE and KORE Controllers only) 
Right under the Knob Page List, the Edit menu grants access to management functions. 
• To access any of these functions, click on the Edit menu and select the desired entry. 

Fig. 10.22. The Edit menu, below the Knob Page List. 

The following commands are available: 
• New: Creates a new default Knob Page. This new Knob Page is appended at the end 

of the list. You can have as many Knob Pages as you want in your Template. 
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• Duplicate: Duplicates the selected Knob Page and insert it at the next lower position 
in the list. This can be useful to generate several Knob Pages with only a few differen-
ces, without having to start from scratch each time. 

• Copy: Stores the selected Knob Page into your operating system's clipboard. This is 
very useful to move or copy a particular Knob Page to another Template: after having 
selected the desired Knob Page, choose this Copy command, then switch to another 
Template (using one of the methods described above), go back to the Inspector's Pa-
ges tab, select the Knob Page List entry below of which you want to insert the copied 
Knob Page, and use the Paste command. 

• Paste: Inserts the Knob Page stored in the clipboard below the currently selected 
Knob Page. The inserted Knob Page is then automatically loaded. You can use this 
command in conjunction with the Copy command described above to transfer Knob 
Pages between Templates. 

• Delete: Removes the selected Knob Page. The lower entries will move up and fill the 
gap. 

Shift Mode Menu (TRAKTOR KONTROL X1 and AUDIO KONTROL 1 only) 
Right under the Knob Page List, the Shift Mode menu allows you to adapt the behavior of 
the Shift Button used to switch between the two Knob Pages available on the TRAKTOR 
KONTROL X1 and on the AUDIO KONTROL 1. 
The effect of the two settings Toggle and Gate is explained at section 17.2.1, Switching 
Between Knob Pages (for the TRAKTOR KONTROL X1) and 19.2, Special Control Ele-
ments (for the AUDIO KONTROL 1). 

The Pad Pages Functionality (MASCHINE Controller only) 
For the MASCHINE Controller, the lower part of the Pages tab offers an additional area 
that allows you to manage your optional Pad Pages. 
The Pad Pages are sets of assignments for the sixteen Pads of your MASCHINE Controller. 
For example, the Pad Pages can be used to store the assignments for various patches of 
your target instrument, or for different instruments in your setup. Please refer to section 
t4.3.3, Pad Pages (MASCHINE Controller only) for more info on the Pad Pages. 
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Fig. 10.23. The Pad Pages button allows you to activate/deactivate the Pad Pages functionality. 

At the top of this area, you first see the Pad Pages button. This button allows you to acti 
vete/deactivate the Pad Page feature for your MASCHINE Controller. 
• To activate the Pad Pages, click on the Pad Pages button. 
The button switches on (blue light) and the lower part of the Pages tab is activated. 
• To deactivate the Pad Pages, click again on the button 
The button switches off, the lower part of the Pages tab becomes grayed out. 
While describing the rest of this area we assume that this Pad Pages button is activated... 

Fig. 10.24. The Pad Page List, at the bottom of the Pages tab. 

Below the Pad Pages button, you see the Pad Page List. This list shows all available Pad 
Pages for the current Template. In this list, each entry represents a Pad Page. The current-
ly selected Pad Page is highlighted in the list. 
• To select another Pad Page, simply click on its entry. 
The selected Pad Page is automatically loaded, along with its control assignments for the 
sixteen Pads. 

Controller Editor - Operation Manual - 108 

EFTA_R1_00171128 

EFTA01810230



Reference 
The Inspector 

O You can also select another Pad Page via the Pad Page menu on the top of the Pad Page 
area or via the Group Buttons (labeled A to H), in the Hardware area or on your MA-
SCHINE Controller. See section ' 10.3.5. The Pad Pages (MASCHINE Controller only) 
for more info on this. 

Each entry in the Pad Page List has two elements: the Pad Page letter and the Pad Page 
name. The Pad Page letter is not editable—it defines the order of appearance of the Pad 
Page in the list and links the Pad Page to the corresponding Group Button in the Hardware 
area and on your MASCHINE Controller. The Pad Page name is editable: 
• To rename the Pad Page, double-click on its name (it is then highlighted), type a new 

name, and press [Enter] on your computer keyboard. 
Like in the other lists, you can reorder the Pad Pages in the list via drag and drop: 
• Click on the desired Pad Page in the list, move your mouse vertically while holding 

the mouse button depressed, and release the mouse button at the desired location. 
The Pad Page takes its new place in the list. 
This can be useful in a live situation, for example if you plan to use several Pad Pages for 
addressing different parts of a song or sequence, and you need to have them in a specific 
order: When they are well ordered, you can easily switch to another Pad Page using the 
Group Buttons (labelled A to I-0 on your MASCHINE Controller. 
The number of Pad Pages is limited to eight (corresponding to the eight Group Buttons on 
your MASCHINE Controller). You'll notice that the MASCHINE Controller mirrors the num-
ber of existing Pad Pages: if some slots in the list are empty, the corresponding Group 
Buttons are off. 

Fig. 10.25. The Edit menu below the Pad Page List. 
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The Edit menu is very similar to the Edit menu to be found below the Knob Page List: 
• New: Creates a new default Pad Page. This new Pad Page is appended at the end of 

the list. As mentioned, you can have up to eight Pad Pages in your Template. 
• Duplicate: Duplicates the selected Pad Page and insert it at the next lower position in 

the list. If there are already 8 Pad Pages in the Pad Page List, the Duplicate entry is 
disabled. 

• Copy: Stores the selected Pad Page into your operating system's clipboard. This is 
very useful to move or copy a particular Pad Page to another Template: after having 
selected the desired Pad Page, choose this Copy command, then switch to another 
Template (using one of the methods described in this manual), go back to the Inspec-
tor's Pages tab, select in the Pad Page List the Pad Page below which you want to 
insert the copied Pad Page, and use the Paste command. 

• Paste: Inserts the Pad Page stored in the clipboard below the currently selected Pad 
Page. The inserted Pad Page is then automatically loaded. You can use this command 
in conjunction with the Copy command below to transfer Pad Pages between Tem-
plates. If there are already 8 Pad Pages in the Pad Page List, the Paste entry is disa-
bled. 

• Delete: Removes the selected Pad Page. The lower entries will move up and fill the 
gap. If there is only one Pad Page, it cannot be deleted. 

10.4.3 The Assign Tab 
The Assign tab allows you to define all necessary MIDI assignment attributes for a particu-
lar control element. Indeed, it displays and allows to modify the assignment attributes for 
the control element that is currently selected in the Hardware area—in other terms, the 
one on which the red Selection Frame focuses. 
As a reminder, to select a particular control element for editing, do the following: 
1. Select a Template. 
2. Select a Knob/Pad Page if the desired element is located in a Knob/Pad Page. 
3. Click on the control element in the Hardware area or touch it on your NI Controller—

provided that the Touch Select option is activated. The Assign tab then displays the 
assignment properties for that control element. 
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The Description Area 

Fig. 10.26. The Description area of the Assign tab. 

At the top of the Assign tab, the Description area displays some descriptive attributes for 
that control element. This section is common to all types of assignments. It contains the 
following information: 
• The first line contains the number and the name of the Knob/Pad Page containing the 

selected control element (this line is empty for control elements which are not includ-
ed in the Knob Page area or, for the MASCHINE Controller, in the square of Pads). 
This is not editable. 

• The second line displays the element description (i.e. its "name" referring to its origi-
nal function in its dedicated software) on the left, which is for info only. On its right, 
it also displays the Label Field, which is its user-definable name. The content of this 
Label Field is mirrored in the Hardware area above the control element itself. 

• To modify the name in the Label Field, double-click on it, type a new name and press 
lEnterl on your computer keyboard. 

Both Label Fields (in the Assign tab and in the Hardware area) are updated accordingly. 
If no name has been defined yet for a control element, its Label Field displays by default 
the MIDI message assigned to this control element. 

O To reset a field to its default name, clear the field, then press the (Enter) key on your 
computer keyboard. 
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The Definition Area 
Below the Description area, the assignment properties explicitly define what has to be sent 
when you actuate the control element on your NI Controller: this is called the Definition 
area. The properties in the Definition area differ according to the type of control element 
currently selected: since a button, a knob and a pad don't have the same behavior, they 
won't be able to trigger the same types of MIDI events. 
Furthermore, some control elements on certain NI Controller can respond to two different 
actions: 
• The Pads of the MASCHINE Controller can be hit, but they can also be pressed. 
• The Controller Knobs of the KORE Controllers are touch-sensitive: they can be turned 

like any usual knob, but they can also be touched. 
• The Push Encoders of the TRAKTOR KONTROL X1 can be both turned and pushed. 
For these double function elements, the two possible actions lead to two possible MIDI 
messages. Hence, the Definition area displays two corresponding Action tabs, each of 
them defining the MIDI event for one specific action. 
For the control elements with only one function, the Definition area does not display any 
tabs, but directly displays the assignment properties for the unique MIDI assignment of 
this control element. 

The top of the Definition area differs if the control element has one or two functions—at 
the top, the assignment for a Button, and at the bottom the two Action tabs for a Pad on 
the MASCHINE Controller. 
The label on each tab's header indicates the particular hardware action that will trigger the 
MIDI message specified in that tab: for example, for a Controller Knob on the KORE Con-
troller, you will find the Turn tab and the Touch tab. 
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MIDI Message Types 
In the Definition area, all control element assignments start with the same menu: the Type 
menu. This menu specifies the type of MIDI message that has to be sent upon action on 
this control element. Depending on the type of hardware control element, the entries in 
this menu will differ (for example, sending a "play" command from a knob wouldn't make 
much sense). 

Fig. 10.27. The Type menu allows you to choose from various MIDI message types. 

• To select a MIDI message type, click on the menu and select the desired entry from 
the list. 

All other parameters displayed in the Assign tab's Definition area depend both on the type 
of control element that you are working on, and on the MIDI message type selected in this 
Type menu. 
Below is a list of all possible MIDI message types to be found in the Type menu. Keep in 
mind that depending on the selected control element, some of them are not available in 
its Type menu. In the next sections, we will explain the particularities for each control ele-
ment available on your NI Controller. 
• Note: Sends a MIDI Note On/Off message. This message is sent over a specific MIDI 

channel set by the Channel parameter (range from 1 to 16, 1 by default). It tells your 
target to play or stop the MIDI Note specified via the Note parameter (range from C-2 
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to G8). The message also defines the velocity at which the note is played. This veloci-
ty is specified in various ways, depending on the type of the selected control element 
(see below). 

• Note (Incremental): Sends a MIDI Note On message. This message type is actually 
made for specific situations where some function in the target software must be trig-
gered by an incoming Note On event. This can be the case, for example, for scrolling 
through lists, where the target software only offers a trigger control for selecting the 
"next" or the "previous" item in the list. With this Note (Incremental) message type, 
you can use the KORE Controller's Scrollwheel or a TRAKTOR KONTROL X l's Push 
Encoder to scroll through the list in the target software. The message is sent over a 
specific MIDI channel set by the Channel parameter (range from 1 to 16, 1 by de-
fault). Two additional parameters, Note Down and Note Up, define the MIDI Notes to 
trigger upon turning the control anti-clockwise and clockwise, respectively. 

• Control Change: Sends a MIDI Control Change message. This message is sent over a 
specific MIDI channel set by the Channel parameter (range from 1 to 16, 1 by de-
fault). This message tells your target to change the value of a specific continuous 
controller—controlling for example some effect's depth in your music application. The 
continuous controller (CC) number is specified via the Number parameter (range from 
0 to 127). The values to be sent for that controller are specified in various ways, de-
pending on the type of the selected control element (see below). 

• Poly Pressure: Sends a MIDI Poly Pressure message (also called Polyphonic After-
touch). This message is sent over a specific MIDI channel set by the Channel parame-
ter (range from 1 to 16, 1 by default). It specifies the pressure at which a particular 
MIDI note is held down. The MIDI note is specified via the Note parameter. The pres-
sure values to be sent are specified in various ways, depending on the type of the se-
lected control element (see below). 

• Channel Pressure: Sends a MIDI Channel Pressure message (also called Channel After-
touch). This message is sent over a specific MIDI channel set by the Channel parame-
ter (range from 1 to 16, 1 by default). It specifies a common pressure at which all 
notes of the MIDI channel are held down. The pressure values to be sent are specified 
in various ways, depending on the type of the selected control element (see below). 
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• Program Change: Sends a MIDI Program Change message. This message is sent over a 
specific MIDI channel set by the Channel parameter (range from 1 to 16, 1 by de-
fault). It tells the target to switch to another program (or patch, preset...). The pro-
gram number to be sent can be specified in various ways, depending on the type of 
the selected control element (see below). 

• Pitchbend: Sends a MIDI Pitchbend message. This message is sent over a specific 
MIDI channel set by the Channel parameter (range from 1 to 16, 1 by default). It is 
used to control the Pitchbend Wheel (and anything that would respond to the MIDI 
Pitchbend message in your target). This is quite similar to a Control Change message, 
but for historical and practical reasons (on most hardware controllers/keyboards, the 
Pitchbend wheel is a very specific control element), the Pitchbend is a distinct mes-
sage in the MIDI specifications. 

• Start: Sends a MIDI Start Song message. As its name implies, this message should be 
understood by your sequencer as a Start command. This message tells your sequencer 
to start playback of the song/sequence from the beginning. There is no parameter 
needed for this message. 

• Stop: Sends a MIDI Stop Song message. This should be understood by your sequencer 
as a Stop command. This message tells your sequencer to pause the playback of the 
song/sequence at its current position. There is no parameter needed for this message. 

• Continue: Sends a MIDI Continue Song message. As its name implies, this message 
should be understood by your sequencer as a Continue command. This message tells 
your target to start playback of the song/sequence from the current position. There is 
no parameter needed for this message. 

• Song Position: Sends a MIDI Song Position message. This message tells your target to 
cue the playback to a specific position in the song/sequence. Note that it does not 
start the playback itself. The message is implemented in a specific way that allows 
you to switch between 2 positions in the song or sequence. The position(s) in the 
song or sequence can be specified in various ways, depending on the type of control 
element (see below). The position in the song is counted in MIDI beats. 

• MCU V-Pot: Emulates one of the Mackie Control®'s 8 V-Pots. 
• MCU Channel: Emulates one of the Mackie Control®'s 8 channel faders. 
• MCU Master: Emulates the master fader of the Mackie Control®. 
• MCU Wheel: Emulates the Wheel of the Mackie Control®. 
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• MCU Button: Emulates the buttons of the Mackie Control®. 
• Off: Deactivates MIDI for the control element. This control element doesn't send any 

MIDI message, hence no parameter is displayed. 

Button, Foot Switch, Knob-"Touch", Push Encoder-"Push" and Pad-"Hit" Modes 
For the Buttons, the Knobs-"Touch" (i.e. when you touch the Knobs on the KORE Control-
ler), the Push Encoders-"Push" (i.e. when you push the Push Encoders on the TRAKTOR 
KONTROL X1) and the Pads-"Hit" (i.e. when you hit the Pads on the MASCHINE Control-
ler), and only for some of the MIDI message types available for these control elements, you 
can choose from different behaviors for the way the data is sent. This is controlled by the 
Mode menu. This menu can have different entries, depending on the message type that you 
have selected in the Type menu. Here is the list of all possible entries: 
• Toggle: In this mode, the control element has two states, On and Off. If you press 

once, it switches to the On state—if you press again, it switches to the Off state. This 
can be useful for example for activating some effect, then deactivating it later. This is 
usually the default mode. In this mode, you find two numeric fields: Off Value defines 
the value for the Off state (from 0 to 127, 0 by default), and On Value defines the 
value for the On state (0 to 127, 127 by default). 

• Gate: In this mode, the element switches to the On state for the time it is held de-
pressed. As soon as you release it, it switches back to the Off state. It is similar to the 
behavior of a key on a keyboard: the note is played when you hold the key depressed, 
and the note is switched off when you release the key. Like in Toggle mode, you find 
two numeric fields: Off Value defines the value for the Off state (from 0 to 127, 0 by 
default), and On Value defines the value for the On state (0 to 127, 127 by default). 

• Trigger: In this mode, only one message is sent when you hit the control element. 
There are no On or Off states. For example, this can be useful for switching to another 
program (preset, patch...) or for triggering one-shot samples (e.g. drum sounds or any 
other envelope-controlled sounds). In this mode, you thus find only one numeric field 
called Value, defining the value to be sent when you hit the control element. It goes 
from 0 to 127 (127 by default). 
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• Increment: In this mode, each action on the control element increases/decreases the 
parameter value. Two numeric fields Range define the min and max values of the in-
terval, each of them ranging from 0 to 127 (by default, 0 for the min and 127 for the 
max). Below, another numeric field called Step defines the increment to add (or to 
subtract if negative) each time that you press the button (it goes from -127 to 127, 
with 1 as default value). Finally, the Wrap button allows you to "cycle" the interval: If 
this button is activated, once the parameter reaches one of its limits, it jumps to the 
other one upon the next time you hit the control element. If the Wrap button is deac-
tivated, the message sent upon the next hit keeps the maximal (or minimal) value for 
the parameter. 

Assignments for the Knobs (MASCHINE Controller and KORE Controllers) and for AUDIO KONTROL l's 
Controller Knob 
For the Knobs of the MASCHINE Controller and of the KORE Controllers ("Turn" action) 
and for the Controller Knob on the AUDIO KONTROL 1, the Type menu offers the follow-
ing entries: Control Change (default setting), Poly Pressure, Channel Pressure, Program 
Change, Pitchbend, MCU V-Pot, MCU Channel, MCU Master and Off. 

O A general description of these MIDI message types can be found in the "MIDI Message 
Types" section above. 

For Control Change, Poly Pressure, Channel Pressure and Program Change, two numeric 
fields labeled Range define the min and max values of the interval, each of them going 
from 0 to 127 (by default, 0 for the min and 127 for the max). 
For the type Pitchbend, the two numeric fields range from -100% to 100%. 
For all message types mentioned above, a numeric field labeled Resolution defines the 
physical angle on your knob that is needed to reach both limits of the interval (as defined 
by the Range parameter). Its values go from 30 to 3600 degrees (360 by default, i.e. one 
full revolution). For example, if you choose 3600 (degrees), you will need to turn your 
knob ten times in order to go from the minimum value to the maximum value defined by 
Range. 
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Finally, all types except Pitchbend and Program Change show a Display menu: this lets you 
decide if you want to have the zero in the middle of the interval (bipolar) or at the begin-
ning (unipolar, by default). This is up to you, since it depends on what you plan to control 
with this assignment. 
Actually, there is a good reason why neither Pitchbend nor Program Change types offer 
this parameter: the Pitchbend type is always bipolar; and the Program Change type is al-
ways unipolar (you wouldn't switch to a negative Program number...). 

Assignments for the Pedals (KORE Controller and RIG KONTROL 3) and Effect Knobs (TRAKTOR 
KONTROL X1) 
The Effect Knobs of the TRAKTOR KONTROL Xl, the Expression Pedal of the RIG KON-
TROL 3 along with the pedal inputs on the KORE Controller and RIG KONTROL 3 are sim-
ilar to a rotary encoder with the noticeable difference of their physically limited ranges. 
Hence, for the Pedals, the Type menu offers the following entries: Control Change (default 
setting), Poly Pressure, Channel Pressure, Program Change, Pitchbend, MCU Channel, 
MCU Master and Off. The Effect Knobs of the TRAKTOR KONTROL X1 offer the additional 
MCU V-Pot message type. 

O A general description of these MIDI message types can be found in the "MIDI Message 
Types" section above. 

For Control Change, Poly Pressure, Channel Pressure and Program Change, two numeric 
fields Range define the min and max values of the interval, each of them going from 0 to 
127 (by default, 0 for the min and 127 for the max). 
For the type Pitchbend, the two numeric fields range from -100% to 100%. 
As you can see, these control elements are very similar to the Knobs described above, with 
the following differences: 
• The message type MCU V-Pot is not available for the Pedals. 
• There are no Display menu nor Resolution parameters here. 
This second difference is simply due to the fact that these control elements are not end-
less encoders. 
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Assignments for the Buttons and Foot Switches 
For the Buttons, Foot Switches or Footswitches Ports of all Controllers, the Type menu of-
fers the following entries: Note, Control Change (default setting), Poly Pressure, Channel 
Pressure, Program Change, Pitchbend, Start, Stop, Continue, Song Position, MCU Button, 
and Off. 

O A general description of these MIDI message types can be found in the "MIDI Message 
Types" section above. 

For the Note, Control Change, Poly Pressure, Channel Pressure, Program Change, Pitch-
bend and Song Position message types, you find the Mode menu defining the behavior of 
the currently selected button/footswitch. 
Here is an example to see the effect of this Mode menu with one of these MIDI message 
types. We will take the Song Position type. As we said, this message allows you to cue the 
playback position to a particular point in your sequence or song. For this message, three 
button modes are available: Toggle, Trigger and Gate. Depending on the one you choose, 
the button will have different behaviors: 
• Toggle: The On Value and Off Value parameters define two different positions in the 

song/sequence. When you press the button once, the play position marker jumps to 
the position defined by the On Value. When you press it again, the playback jumps to 
the position defined by the Off Value. 

• Trigger: The Value parameter defines a single position in the song or sequence. Each 
time you press the button, the playback jumps to this position. 

• Gate: Like in Toggle mode, the On Value and Off Value parameters define two differ-
ent positions in the song/sequence. When you press the button and hold it depressed, 
you jump to the position defined by the On Value. When you release the button, the 
playback jumps to the position defined by the Off Value. 

For the Toggle, Trigger and Increment modes, an Action on menu allows you to choose if 
the message has to be sent when the button is switched to the Down state (i.e. when you 
hit the button, default setting) or when it is switched to the Up state (i.e. when you release 
the button). For the Gate mode, this parameter wouldn't make sense, since both Down and 
Up state already define the On and Off Values to be sent. 
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Assignments for the Pad-"Hit" and Knob-"Touch" Actions 
The "Hit" action on the Pad of the MASCHINE Controller and the "Touch" action on the 
Knob of the KORE Controller are equivalent. They are very similar to the Button. The Type 
menu offers the following entries: Note (default setting), Control Change, Poly Pressure, 
Channel Pressure, Program Change, Start, Stop, Continue, Song Position, Mal Button 
and Off. 

O A general description of these MIDI message types can be found in the "MIDI Message 
Types" section above. 

Like for the Buttons, for the Note, Control Change, Poly Pressure, Channel Pressure, Pro-
gram Change and Song Position message types, you have a Mode menu defining the behav-
ior of the currently selected control element (see section "Button, Foot Switch, Knob-
"Touch", Push Encoder-"Push" and Pad-"Hit" Modes" above). 
You will notice that there is no Action on menu for the Pads-"Hit" nor for the Knobs-
"Touch." 

Assignments for the Pad-"Press" Action 

The "Press" action on the Pad of the MASCHINE Controller is quite similar to the Knob 
"Turn" action. The Type menu offers the following entries: Note, Control Change, Poly 
Pressure (default setting), Channel Pressure, Pitchbend (very useful for bending the tuning 
of drums by pressure!) and Off. 

© A general description of these MIDI message types can be found in the "MIDI Message 
Types" section above. 

For all types except Note, two numeric fields Range define the minimum and maximum 
values of the interval, each of them going from 0 to 127 (by default, the minimum value is 
0, while the maximum value is 127). 
For the type Pitchbend, the values are displayed in a numeric field called Amount and 
ranging from -100% to 100%. This defines the portion of interval that you want to use for 
the MIDI Pitchbend message: The available interval will go from 0% (when you don't 
touch the Pad) to the Amount parameter (when you press the Pad with full pressure). 
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O Note that this Amount percentage refers to the Pitchbend range that is set in your target 
instrument. Most of the time, the synthesizers offer a range of +/- 2 semi-tones for the 
Pitchbend. In some cases, though, this range is editable by the user. Please refer to your 
instrument's manual for more info. 

For the type Note, you have instead two additional numeric fields Threshold. They define 
the pressure threshold above (below) which the Note On (Off) message is sent. The Off 
threshold should always be smaller than the On threshold (have you ever considered stop-
ping a note before playing it?). Both parameters range from 0% to 100% (as a ratio with 
the maximum pressure). 
As you can see, the settings for the MASCHINE Pad "Press" type are quite similar to those 
of the MASCHINE Knob and KORE Knob "turning a Knob" type. Here is a list of the dif-
ferences: 
• Note type is added—and, for that, the On and Off Thresholds are needed. 
• There is no Resolution parameter, since it only makes sense with the rotary knobs. 
• The Bipolar display mode is omitted, because you have no chance for any symmetri-

cal control around a center using a Pad. 
• Program Change is not available because it would not be controllable. 
• Pitchbend can be controlled but only in one direction: Up or Down. For example, this 

can be very useful for bending the tuning of drums by pressure. 

Assignments for the Scrollwheel (KORE Controller) and Push Encoders-"Turn" (TRAKTOR KONTROL 
X1) 
The "Turn" action on the Push Encoders of the TRAKTOR KONTROL X1 and the action on 
the Scrollwheel of the KORE Controllers are equivalent. They are quite similar to those on 
the MASCHINE Knobs and KORE Knobs-"Turn", but due to their context of use and step-
by-step movement, they have slightly different message types available: Note (Incremen-
tal), Control Change, Poly Pressure, Channel Pressure, Program Change, Song Position, 
MCU Wheel, and Off. 

O A general description of these MIDI message types can be found in the "MIDI Message 
Types" section above. 
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For all types except Note (Incremental), Control Change and MCU Wheel, you find follow-
ing parameters: 
• Two numeric fields Range define the minimum and maximum values of the interval, 

each of them going from 0 to 127 (by default, the minimum value is 0, while the 
maximum value is 127). 

• A numeric field Step defines the increment to add (or to subtract if negative) for each 
step of control element (it goes from -128 to 127, with 1 as default value). 

• The Wrap button allows you to "cycle" the interval: If this button is activated, once the 
parameter reaches one of its limits, it jumps to the other one upon the next move-
ment of the Wheel (or the Push Encoder). If the Wrap button is deactivated, the mes-
sage sent upon the next movement keeps the maximal (or minimal) value for the pa-
rameter. 

Furthermore, for the type Control Change, a Mode menu allows you to select between three 
operating modes: 
• Absolute: This mode is equivalent to the Control Change message type implemented 

for the other control elements. Its parameters are the same as those described above: 
two numeric fields Range, a numeric field Step and a Wrap button (see above). 

• Relative: In this mode, the message sent is in a +1/-1 fashion—actually +11+127, 
which is then understood by the target software as +1/-1 in that case. This allows the 
control element to set the new Control Change value relatively to its current value. 
There is only one parameter called Step which defines the increment to use. 

• Relative (Offset): This mode is similar to the Relative mode explained just above, with 
the difference that here the actual values sent for the "+1" and "-1" messages are 
"65" and "63", respectively—in other terms, they are centered around 64 instead of 
0. This is well suited for some particular software implementations. 

Finally, in contrast to the Push Encoders (TRAKTOR KONTROL X1), the Scrollwheel 
(KORE Controllers) offers an additional Display menu for the message types Control Change 
(Absolute mode), Poly Pressure, and Channel Pressure. This Display menu lets you decide 
if you want to have the zero in the middle of the interval (bipolar) or at the beginning 
(unipolar, by default). This is up to you, since it depends on what you plan to control with 
this assignment. Since the TRAKTOR KONTROL X1 does not have any display, such a Dis-
play menu would not make much sense. 
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